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PREFACE 
 

This is the MSc thesis for the master’s programme Geographical Information Management and 

Applications (GIMA). The GIMA master is a combined programme by Utrecht University, Wageningen 

University, ITC Enschede (University of Twente) and the Delft University of Technology. This document 

is the result of a fulltime five month study. I can definitely say that I have been very lucky to get the 

opportunity to conduct this research at two interesting organisations: the municipality of Eindhoven 

and Geodan. Looking back at this period, it truly was an adventure full of challenges. Exploring the 

unknown, getting the right information from a project with many stakeholders and software bugs 

made this period not always easy. The biggest challenge came right after I finished all my interviews: 

an article in ‘Eindhovens Dagblad’ stated that the 3D microphones, one half of my research, failed. 

However I am proud that it did not stop me from going on and being highly motivated.  Especially 

staying motivated was one of the things that made me able to finish this research within the pre-

defined time of five months. 

I would therefore like to express my gratitude to the people that actually kept me motivated until the 

very last day. First of course I would like to thank my professor Jantien Stoter for her substantive 

supervision throughout the research process. After the biggest challenge, she gave me the courage to 

adjust my research questions and to finish the research within the time I was aiming for. Furthermore 

I want to show my gratitude to Heidi van der Vloet of the municipality of Eindhoven and Rene Bruinink 

from Geodan. They gave me the opportunity to work within two very different but interesting 

organisations from which I have learnt a lot. The municipality of Eindhoven provided me insight into 

municipal work processes and substantive information about the case study while Geodan perfectly 

supplemented this with more in-depth knowledge of 3D geo-information. There are also three 

particular fellow GIMA students that deserve a big thank you: Cecile Mathijsen, Jeroen Muller and 

Nikki Hulskes. The daily conversations and monthly dinners, either thesis related or not, were very 

helpful and kept me enthusiastic and motivated throughout the entire research process. Finally I want 

to thank the large group of people that showed their interest in my research, and specifically the 

people included in the list of appendix I that in some way contributed to this document. 

 

Enjoy your reading, 

 

Nikkie den Dekker  

Amsterdam, January 30th 2015  
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SUMMARY 
 

The main question answered in this research is: “What are the opportunities for 3D GIS to increase the 

information level of smart sensor data and to stimulate a better alignment between sensor data supply 

and stakeholder demand in a smart city?” 

The concept of smart cities has become incredibly popular among policy makers over the past few 

years. It is a demand-driven concept that emerged from modern problems in cities, such as traffic or 

crime. The concept has many definitions. However most of the recent definitions focus on the use of 

new ‘smart’ technologies such as cloud computing, sensor networks and Web 2.0 to tackle the 

problems. This research particularly focuses on the sensor networks. Although the idea behind these 

sensor networks in a smart city is that they help to reduce smart city problems, they are often being 

used from a more technology-driven perspective. The risk is that the real problems or requirements by 

the stakeholders for which they were purchased are being overlooked.    

  Furthermore, sensor networks are collecting tremendous amounts of data, also called big 

data. This raises new issues about how to store, manage, protect, analyse and visualise this data. 

Different information levels can be distinguished to show that for instance adding context to data can 

provide new insights for people to derive information from this data. At this moment there is also a 

transition going on from 2D to 3D geo-information in practice. More people are now realising that 3D 

GIS is able to improve the information level of data and to provide a more realistic insight in a real 

world situation.    

  However, as a result of the big data challenges and the relative new development towards 3D 

geo-information most smart cities get stuck with respect to the analysis and visualisation of sensor 

data. Thereby the sensors are currently often used for experiments only.   

Eindhoven is a city in the Netherlands that is said to be a smart city. Stratumseind is the nightlife area 

of Eindhoven and this makes the area very dynamic. The municipality of Eindhoven decided to make 

this area a living lab whereby sensors are being used to monitor the area, to reduce crime and conflict 

and to increase liveability. However the issues described above reflect to a great extent the problems 

that are now faced by Eindhoven. Therefore Living Lab Stratumseind 2.0 serves as the case study for 

this research. The living lab includes 7 different types of sensors. This research focuses only on people 

counting cameras and 3D microphones (for noise measurements) as 3D geo-information is most 

relevant for these sensors.  

Four different groups are distinguished and defined for this research as stakeholders for living lab 

Stratumseind 2.0: the inhabitants of the area, the pub owners, the property owners and the police. 

Based on interviews a few conclusions can be drawn. First it became clear that although requirements 

were diverse, it is important that a reliable visualisation of noise sources is required. The visualisation 

should overall be simple in such a way that anyone will be able to directly recognise patterns in noise 

levels and derive information from the visualisation. Furthermore the inhabitants have a strong need 

for a realistic 3D visualisation of the environment to recognise the specific buildings. Finally, there is a 

need for specific visitor information, i.e. per building or per square meter. When comparing this to the 

availability of sensor data at this moment, it appeared that there is not yet a perfect match between 

sensor data supply and stakeholder demand.   
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Currently the noise sources are determined without the use of 3D objects information. As a result, 

assumptions about noise sources can provide a false picture of reality. It is now assumed that the 

noise is created by people at the street while Stratumseind has lots of bars and pubs that might 

produce noise. With respect to the 3D city model on its own, photos (i.e. textures) can be added to 

the buildings to make it look more realistic and familiar as required by the inhabitants. The people 

counting cameras are currently collecting information about the amount of visitors in the entire area. 

But this information is too rough and global for the demands by stakeholders. Opportunities for 3D GIS 

lay particularly in the use of 3D city model information to make the assumptions about the noise 

sources more reliable and the use of GIS software to make the city model look more realistic. The last 

opportunity is beyond the scope of this research but a test case was made to explore the effect of 

adding 3D information to the noise source determination method. 

With the aid of the available data from Munisense, the supplier company of the 3D microphones, 

several visibility analyses can be performed to better determine the noise sources. The test case 

showed that adding 3D geo-information to this method makes a significant difference. The new noise 

sources are approximately positioned 17,50 meters from the original determined noise sources. This 

large distance causes a completely different overview of locations that are considered as the noise 

source location. Besides this, adding 3D information can provide insight in new patterns. Often 

clusters of noise observations become visible on a specific building.   

Furthermore, it has been explored if 3D GIS can help to visualise the sensor range of the people 

counting cameras and to integrate these in the existing city model. This has been done in two different 

ways. The first is with the aid of the Axis plugin to create 3D camera field of views in SketchUp. The 

second is a toolbox developed by the Dutch company Geodan to create 3D field of view shapefiles in 

ArcGIS. Both methods have some advantages and disadvantages and they are not yet ideal, but both 

methods are able to visualise the camera field of views in an existing city model. Especially the Geodan 

toolbox is a promising tool for the future as it can easily construct field of view shapefiles in an existing 

city model. This tool is still under construction so it will become further developed in the near future. 

The field of view visualisation can be used to inform people about the current situation, but also to 

determine the optimal location for cameras. It is however clear that 3D information is crucial as it 

determines the blocking objects that remove areas from the field of view.  

Further research must show whether there are even more opportunities for 3D GIS related to sensor 

data in smart cities. Without a doubt these opportunities will increase with the increasing interest and 

use of 3D and the rapid development of new 3D tools.  
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GLOSSARY 
 

 
Actuator: devices or technologies to manipulate the environment. This is the opposite of a sensor who 

observes the environment (Verdone et al, 2008). An actuator thus puts something in motion which 

can be a movement, light, sound or magnetism.   

 

AHN2 (‘Actueel Hoogtebestand Nederland’): the second version of the official Dutch height model with 

a detail level of 50 by 50 centimeters. The height model is created from airborne laserscanning data 

(Actueel Hoogtebestand Nederland, 2014).  

 

BAG (‘Basisregistratie Adressen & Gebouwen’):  one of the Dutch key registers in which municipal basic 

information about all buildings and addresses in the Netherlands are collected. It provides an overview 

of almost all buildings in the Netherlands and a high quality address dataset (Basisregistraties IenM, 

2015).  

 

Big data: a concept that describes the tremendous amount of data that is nowadays produced. Some 

key features of big data are that the data is huge in volume, high in velocity, diverse in variety, 

exhaustive in scope, fine-grained in resolution, relational in nature and flexible (Kitchin, 2014). 

 

Data mining: the science or method whereby useful knowledge is extracted from huge data 

repositories (Chakrabarti et al, 2006). The goal of data mining is to obtain understandable and useful 

information (knowledge) from big data in order to use this information for further actions. It is the 

heart of the KDD process (see definition of KDD).  

 

DSS (Decision Support System): a system used to store, handle and process big data which serves as a 

basis for new decisions (Ortega et al, 2014).  

 

DIKW pyramid (Data, Information, Knowledge and Wisdom): a hierarchy model that aims to make a 

distinction between several information levels. The bottom of the pyramid includes raw data, which 

can exist in any form. When context is added to raw data, information is created. Knowledge arises 

when expertise and skills are acquired through education and experience. When the level of wisdom is 

reached in the pyramid, people can derive a profound and deep understanding of key relationships 

and patterns that are critical to a certain activity. Wisdom thus extends knowledge with a higher level 

of cognitive processing (Conger & Probst, 2014).  

 

FoV (Field of View): the range or spatial extent of a camera. A field of view thus literally shows the 

viewing field of a camera. A distinction can be made between actual and potential field of views. The 

actual field of view shows the viewing field of a camera at a specific moment. The potential field of 

view shows the potential viewing field when the camera is being controlled. The potential FoV is 

therefore in particular relevant for dynamic dome cameras.  
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GIS (Geographical Information Systems): offers the possibility to integrate datasets with a spatial 

component from different kind of sources. This could be statistical databases, but also surveys or 

remote sensing. GIS functionality allows people to manipulate this data or to perform geospatial 

analysis. GIS can also be used to visualise geospatial data (Kraak & Ormeling, 2010). 

 

IoT/IoE (Internet of Things/Internet of Everything): refers to the connection of things in the physical 

environment to the internet. This connection is possible due to the use of smart objects, which are the 

building blocks of the Internet of Things. Smart objects are everyday physical things enhanced by 

electronic devices to process sensor data and to support a communication link with the internet. The 

connection created by a smart object makes it possible to monitor and control the physical world from 

a distance. By combining captured data from the sensors with data retrieved from other sources, such 

as the internet, new services emerge (Kopetz, 2011). 

 

KDD (Knowledge Discovery in Databases):  the process of extracting hidden information from large 

datasets. Data mining is the most important step in this process (see definition data mining). The main 

difference is thus that KDD focuses on the overall process. KDD therefore addresses also questions 

about how the data is stored and accessed for instance. It is a multidisciplinary activity (Fayyad et al, 

1996).  

 

LOD (Level of Detail): a concept based on the CityGML standard that defines the differences in the 

level of detail for 3D city models. There are five different levels ranging from LOD0 to LOD4. LOD0 is a 

regional model or a terrain model. Often it is also referred to as a 2.5D model. LOD1 is a city model 

with building blocks. LOD2 is a city or site model whereby rooftops and optional textures are added to 

the block model.  LOD3 is a site model with detailed architectural structures. LOD4 is an interior model 

that contains walkable interior spaces (Rönsdorf, 2010).  

 

User experience design: method that pays attention to how things work, not on the inside but related 

to its context. An important aspect of user experience design is the creation of personas, also referred 

to as user profiles or user models. A persona is a fictional character that represents the needs of a 

group of real users (Garrett, 2011).  

Sensor: a device that observes the environment and collects data about this environment (Verdone et 

al, 2008). It is the opposite of an actuator that manipulates the environment (see definition actuator).  

Smart city: a combination of an instrumented, interconnected and intelligent city. Instrumentation 

refers to the capturing and integration of real-time data through the use of sensors, meters, personal 

devices, cameras, smart phones, the web or other data-acquisition systems. An interconnected city 

means that the captured data is integrated into a platform and that the information is communicated 

among various city services.  Intelligent refers to a combination of analytics, models and visualisations 

in order to make better operational decisions (Harrison et al, 2010).  

 

WSN/WSAN (Wireless Sensor Network/Wireless Sensor Actuator Network): a WSAN is a network 

consisting of devices that sense the environment and communicatie the collected data through 

wireless links (Verdone et al, 2008). The difference with a WSAN is that a WSAN also contains 

actuators (see definition ‘actuator’).  
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1 INTRODUCTION 
 

“The first stage of a smart city is to have a basic infrastructure. Now the real challenge is the second 

phase, to integrate those systems into daily life (…) for citizens in a way that they can actually use it” 

(Smedley, 2013). This sentence is part of the article that The Guardian posted at the end of 2013. It 

argues that the new smart city is one that, besides hi-tech sensors, includes social innovation. Systems 

must not only monitor citizens, but they should engage them. The smart city should strive to go 

beyond just some nice experiments.  

 

1.1 Introduction 
The term smart city has become a buzzword over the past few years to identify cities with innovative 

and sustainable solutions concerning modern problems such as waste and traffic congestion. 

Especially marketers and policy makers use this term frequently. The exact meaning of a smart city is 

rather broad and vague as hundreds of definitions exist both in literature and daily life. It is however 

known that in order to become smart, the city needs data. To be more specific, a smart city needs 

real-time data. The real-time data is needed to monitor and control the processes within a city. The 

real-time data can furthermore be integrated with other data sources to create added value and to 

establish a framework for smart initiatives and better decision making. Essential for this is a sensor 

network. These sensors can be of any type, such as cameras, smartphones, meters for temperature or 

sound et cetera. The main challenge is that all these sensors together create a tremendous amount of 

data. This raises new issues regarding data storage, security, privacy, data analysis and visualisation. 

Furthermore the rapid technology developments and the fast implementation of sensors might cause 

a mismatch between data supply and stakeholder demand.  

  

Eindhoven is one of the cities in the world that has been appointed as being a smart city at the 2014 

smart city awards by The New Economy (The New Economy, 2014). Currently, the municipality of 

Eindhoven is experimenting with different kinds of smart sensors in order to stimulate liveability and 

to reduce crime and conflict. There are several areas in the city of Eindhoven where smart sensors are 

located. Most of the sensors are located in the street called Stratumseind, which is the nightlife area 

of the city. This area is known to be very dynamic with few visitors at daytime and high visitor peaks 

during the night and weekend, which sometimes leads to conflicts. Due to this dynamic character, it is 

a perfect place to experiment with (the effect of) smart sensors concerning public safety and 

liveability. Therefore this area was identified as a ‘living lab’. A living lab is an instrument to measure 

the influences of interactions between people and/or the environment by means of for instance 

lighting, smell or design. The living lab Stratumseind serves as a central platform for all involved 

stakeholders such as the police, hospitality businesses and residents. This living lab in Eindhoven is 

called ‘Living Lab Stratumseind 2.0’ and it is one of the cases of the new Dutch initiative ‘Making Sense 

for Society’. This initiative serves as an open platform for the triple helix (business, government and 

research institutions) to deal with new issues that arise from the Internet of Things. Furthermore, the 

living lab itself is also a central platform for the quadruple helix structure. This structure contains, 

apart from the triple helix, also the residents of the city. This quadruple helix is one of the main 

strategies and strengths of the municipality of Eindhoven.  
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Eindhoven is also one of the few Dutch municipalities who already make use of 3D. They currently 

have a 3D model available of the entire city. This model has a so called LOD (level of detail) 2 which 

means that the model contains the building blocks and the roof structures. The ambition of Eindhoven 

is to use this existing 3D city model for new purposes, including the Living Lab Stratumseind. The big 

data challenges mentioned earlier are also faced by the municipality of Eindhoven. Currently the main 

challenges for Eindhoven focus on the one hand on sensor data visualisation in their 3D city model and 

on the other hand on privacy issues. Living Lab Stratumseind 2.0 will be used as a case study for this 

research. This research will focus on the sensor data visualisation challenge to increase the 

information level of the sensor data. The stakeholders of sensor data will play a central role in this 

research. The research also consists of a study to indicate and better align stakeholder demand and 

sensor data supply. The question that will be answered is: “What are the opportunities for 3D GIS to 

increase the information level of smart sensor data and to stimulate a better alignment between 

sensor data supply and stakeholder demand in a smart city?”    
 

1.2 Reading guide 
The next chapter contains the problem statement which provides an overview of all research 

questions, deliverables and a brief explanation about the research scope. Chapter 3 contains the 

literature study. In this chapter all underlying developments and concepts, such as the smart city and 

big data, will be elaborated. Chapter 4 describes the methodology to complete the research. This 

chapter also explains the overall approach and justifies the used methods. Chapter 5 then describes 

the results and findings of these experiments. This chapter contains furthermore the discussion points 

that should be taken into account. The final chapter provides an answer to the main research question 

and it proposes some recommendations for future research or actions.  
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2 PROBLEM STATEMENT  
 

This chapter describes the main problem that will be addressed during this research. The chapter 

consists of the following sections: 

 

 2.1  –  Problem statement: explains the problem currently experienced in Eindhoven that 

forms the occasion to conduct this research. 

 2.2   –   Research questions and deliverables: lists all research questions and the associated 

deliverables that should be the result of this research. 

 2.3  –  Research scope: defines the research scope and describes the aspects that are not 

included in the research scope.  

 

2.1 Problem statement 
Cities are more and more looking for smart solutions for modern problems in a smart city. With the 

advent of new technologies and associated cost reductions of these new technologies, smart cities are 

getting widely equipped with sensors. As this is a rather new development, the initiatives for which 

the sensors are installed are often experimental. Sensors are getting implemented so fast that often 

the underlying problems or questions for which the sensors are bought are being overlooked. This 

may result in a skewed relation between sensor data supply and stakeholder demand. Big data 

challenges are furthermore threatening the high potential of these sensors to extract useful 

information from this sensor data. The raw sensor data should be transformed into information and 

knowledge to actually stimulate better decisions to deal with underlying problems of the smart city. 

 

The smart city concept is applied to Eindhoven in several initiatives. This research focuses on the living 

lab Stratumseind 2.0 and the main purpose of this living lab is to maintain, control and monitor public 

safety. At present, the city of Eindhoven has a broad range of smart sensors located in Stratumseind to 

monitor the area on a real-time basis. The collection of smart sensors and actuators includes visitor 

counting cameras, temperature sensors, 3D decibel recorders, smart lighting, social media detection 

equipment, mac readers and origin sensors. These sensors will be explained in more detail in section 

4.3.4. The street also accommodates a control centre with several dashboards where the sensor data 

can be examined. Kitchin (2014) argues that such centres are very powerful to manage and make 

sense of living in the city, both now and in in the future. 

  At present the living lab is facing some of the big data problems that will be explained in more 

details in the next chapter. Especially privacy issues and data analysis and visualisation difficulties are 

the main challenges in Eindhoven. Currently there is no visualised overview of the locations and range 

of the sensors. This information is needed as a starting point for further analysis. It is for example 

currently not clear if there are any black areas concerning the sensor coverage. Furthermore there is a 

need to visualise the final output data of the sensors in such a way that it can be understood and 

analysed by the people who contribute to the decision making process of the area. The 3D city model 

with the location and data of smart sensors can serve as a basis for a user interface for all stakeholders 

of the area. To be able to do this a clear overview should be created of all different stakeholders and 

the requirements they have concerning the sensor data in general and the visualisation of this sensor 

data. Since the measurements of the smart sensors are being collected in at least three dimensions, it 

is required to store and visualise the sensor data in at least three dimensions as well. Otherwise the 
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data will lose detail or the resulting image will become cluttered. Therefore there is a need to model 

both the sensors and the sensor data in a 3D model of the city.    

  Eindhoven is one of the few Dutch municipalities that were already experimenting with 3D at 

the beginning of 2014. They currently have a three-dimensional model available of the entire city. This 

3D model was created earlier from a combination of BAG data (Dutch key registration for buildings 

and addresses) and the Dutch national height model (AHN2) obtained from laser altimetry. In terms of 

its living lab Stratumseind with various types of smart sensors and actuators, the city of Eindhoven is 

unique in Europe. The current problem faced by the municipality of Eindhoven is that they do not 

know how the sensor data can be modelled and visualised effectively. Living Lab Stratumseind 2.0 will 

serve as a case study for this research to overcome and reduce some of these problems.   

 

2.2 Research questions and deliverables  
The main research question that will be answered during this research is: “What are the opportunities 

for 3D GIS to increase the information level of smart sensor data and to stimulate a better alignment 

between sensor data supply and stakeholder demand in a smart city?”. The research can be 

subdivided into two different parts. The first part focuses on the stakeholder requirements and the 

alignment of these requirements with the available sensor data. The second part focuses on the 

visualisation of camera field of views in an existing city model.  

 

The goal of the research is to increase the information level of the current available sensor data with 

the aid of 3D GIS. Furthermore this research defines the requirements of sensor data stakeholders 

concerning both the sensor data in general and the visualisation and analysis capabilities of the data. 

Based on these requirements it can be examined to what extent these requirements match the 

current availability of sensor data and how 3D GIS can contribute to a better alignment of supply and 

demand. The overall aim of the visual data exploration is to represent data in some visual form that 

allows the stakeholders to get better insight into information they need derived from the data.  

 

The main question will be answered based on five sub questions. 

 What has been done already, both by academics and practitioners, concerning 3D+time 

visualisation of geographical sensor data? 

 Who are the stakeholders of smart sensor data and what requirements do they have 

concerning sensor information and visualisation? 

 To what extent do these requirements match the current availability of information? 

 How can 3D GIS contribute to a better alignment of data supply and stakeholder demand? 

 How can 3D GIS be used to visualise the spatial extent of sensors? 

The first sub question focuses on the general practices concerning the three-dimensional visualisation 

of sensor data and is answered by a literature study of both practical and academic materials. This sub 

question is used to explore the current practices and initiatives for visualisation of sensor data. The 

other sub questions are applied to the case study. The case study focuses specifically on the Living Lab 

Stratumseind 2.0 in Eindhoven. In order to answer the main question, it is of importance to define the 

stakeholders of the sensor data. In the end, they are the people who should be able to interpret and 

understand the information provided.  It is therefore also needed to define the requirements they 
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have concerning the data in general and the visualisation possibilities of sensor data. These 

requirements should then be compared to the current available data to explore whether the data 

matches the stakeholder demand. Furthermore, the information required from the third and fourth 

sub question should lead to at least one test case showing how 3D can contribute to a better 

alignment of data supply and stakeholder demand.  The final sub question addresses the location and 

range of the sensors that is needed to examine the visibility coverage and to increase the information 

level.  

The research questions should in the end lead to the following deliverables:  

1. A theoretical overview of the current applications/practices of visualised sensor data 

2. A clear definition of the target group, i.e. the stakeholders of Stratumseind that contribute 

to the decisions made about the area 

3. A 3D model of Stratumseind with a visualisation of the location and range of the sensors 

4. An overview of the sensor data requirements of the stakeholders, both in general and 

concerning visualisation practices, elaborated in personas 

5. A description of the match between sensor data supply and stakeholder demand 

6. A test case showing how 3D GIS can contribute to a better alignment of data supply and 

demand 

7. A webscene of the area 

8. A methodological description of how deliverables 3 and 6 can be realised  

 

2.3 Research scope 
The research has several limitations that define the scope. The graduate period is 5 months full time 

(40 hours a week) and therefore not every aspect relating to the main question can be examined. As 

mentioned in the background, several challenges have arisen from new technologies producing 

tremendous amounts of data. However not all of these challenges will be addressed in this research. 

This research focuses mainly on challenges concerning visualisation and analysis of big data. The 

research will therefore not pay attention to other challenges, such as data capturing, data storage and 

data security. Another major challenge that is also experienced by the municipality of Eindhoven are 

privacy and ethical issues. This research does also not address these.  

The research will furthermore not examine all devices that are part of the wireless sensor actuator 

network (WSAN) in the Stratumseind area. The WSAN of Stratumseind contains both sensors, e.g. 

cameras, and actuators, e.g. smart street lights. Not all sensors and actuators are relevant for the 

questions stated during this research. For example, social media detection sensors are not relevant for 

the visualisation of sensor range. The social media sensors only detect posts about the area and 

recognises whether these posts are positive, negative or neutral. This detection is based on certain 

words that exist within the posts and it has therefore nothing to do with the location and range of 

sensor itself. The smart street light actuators are furthermore not yet fully installed in the area. The 

research will therefore focus on visualisation of the 3D microphones and the visitor counting cameras.   
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This research does also not focus on the improvement or correction of the current 3D city model of 

Eindhoven. The city model has is currently LOD2 (level of detail 2) and it is not supplemented with 

colours or photos. There are also quite some errors concerning the geometry of the city model. During 

this research, the city model as it is now will be used as an environment to integrate sensor data in. No 

attention will be paid to the improvement of the city model.  

Finally, the research focuses on visualisation of sensor data in three dimensions. It does therefore not 

pay attention to the discussion whether 1D or 2D visualisations are sufficient or even better for final 

decision making.  
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3 LITERATURE STUDY 
 

This chapter examines the theoretical background of the research. The most important underlying 

concepts and developments will be explained in more detail. The chapter provides more insight into 

the context of the sensor data visualisation problem. The chapter consists of the following sections: 

 

 3.1 – The smart city: explains the concept of a smart city. It makes a distinction between 

differences in smart city definitions that evolved over the years. 

 3.2 – The foundation of a smart city: describes the basic elements of a smart city: the Internet 

of Things and the digital city. It also explains the difference between the concepts Internet of 

Things and smart city.  

 3.3 – Technology push vs. demand pull: addresses the difficulties that can emerge in a smart 

city where technology push meets demands pull.  

 3.4 – Sensor vs. actuator: makes a distinction between the definition of a sensor and the 

definition of an actuator as this latter concept is often mistakenly called a sensor.  

 3.5 – Big data challenges: describes the concept of big data and all the challenges that are 

associated with the rise and production big data.  

 3.6 – From data to wisdom: The DIKW pyramid: aims to make a distinction between different 

information levels by using the concept of the Data, Information, Wisdom, Knowledge model.  

 3.7 – The transition from 2D to 3D: describes the current development in the practical field 

towards the use of 3D geo-information.  

 3.8 – Current practices: describes the tools and literature of current practices that relate to 

this research. This section makes a distinction between current practices related to the 

visualisation of on the one hand sensor range and on the other hand sensor values. 

 3.9 – Conceptual model: graphically shows the relationships between the most important 

concepts and developments described in this chapter. 

 3.10 – Conclusions: provides an answer to the first sub question.  

 

3.1 The smart city  
The concept of smart cities has become incredibly popular among policy makers over the past few 

years. Eindhoven is one of the cities that is said to be a smart city. While the term is definitely useful 

for marketing purposes, the concept of a smart city is rather fuzzy. The smart city has many different 

definitions in both daily life and academic literature. The meaning of ‘smart’ also varies among 

different sectors. In the marketing sector the word is smart is more aimed at user-friendliness while it 

has a more ideological and strategic dimension in the urban planning sector (Nam & Pardo, 2011).

    

The definitions of a smart city can be roughly distinguished between a social and a technical 

viewpoint. The definition by Rios (cited by Nam & Pardo, 2011, p. 284) is an example of the former 

category. He defines a city as smart when it is able to inspire and motivate inhabitants to flourish their 

own lives, e.g. by sharing knowledge and culture. Partridge (2004) aims more at the role of a city to 

stimulate social inclusion and equal participation as a result of smart city initiatives.   

  During the past few years the technical aspects of a smart city has gained more importance. 

Therefore the definitions of a smart city also changed. More emphasis has been put on innovative 

technologies, such as cloud computing, smart sensor networks and Web 2.0, which can be used to 
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make a city more sustainable or liveable. A definition that highly reflects the practices in Living Lab 

Stratumseind 2.0 was made by Harrison et al in 2010. They define the smart city as being a 

combination of an instrumented, interconnected and intelligent city. Instrumentation refers to the 

capturing and integration of real-time data through the use of sensors, meters, personal devices, 

cameras, smart phones, the web or other data-acquisition systems. An interconnected city means that 

the captured data is integrated into a platform and that the information is communicated among 

various city services.  Intelligent refers to a combination of analytics, models and visualisations in order 

to make better operational decisions (Harrison et al, 2010).  

 

Although the recent definitions focus mainly on the technical viewpoint of a smart city, the smart 

initiatives that contain Information and Communication Technologies (ICT) do not only entail 

technological changes. ICT is complementary to human and organisational capital and the usage is 

shaped by political choices, local authorities and citizens (Neirotti et al, 2014). Both viewpoints are 

therefore important to establish a successful smart city strategy.   

 

3.2 The foundation of a smart city  
The Internet of Things (IoT), also referred to as Internet of Everything, is a concept that has emerged 

during the past few years because of rapid technology developments and further cost reduction. It 

refers to the connection of physical things to the internet. This connection is possible due to the use of 

smart objects, which are the building blocks of the Internet of Things. Smart objects are everyday 

physical things enhanced by electronic devices to process sensor data and to support a communi-

cation link with the internet. The connection created by a smart object makes it possible to monitor 

and control the physical world from a distance. By combining captured data from the sensors with 

data retrieved from other sources, such as the internet, new services emerge. This is the vision where 

the Internet of Things is based on (Kopetz, 2011). In simple words, the physical world is becoming a 

type of information system where everything is connected to everyone (Bhimani & Willcocks, 2014). 

 

The definitions of the Internet of Things and the smart city are at some point similar. The main 

difference between the smart city and the Internet of Things is however that the former is demand-

driven and the latter is rather technology-driven. The smart city has emerged because of problems in 

the modern city such as waste, pollution, traffic congestion, energy and crime. In order to be(come) 

sustainable, the city needs smart solutions to these problems. As mentioned before, the Internet of 

Things has mainly emerged because of rapid technology developments (Perera et al, 2013) and it is 

not necessarily used for smart urban development. However, the Internet of Things and smart city 

concepts have become more intertwined. The Internet of Things can nowadays be seen as one of the 

crucial buildings blocks of the smart city.  

  To lay a foundation for the smart city, the Internet of Things can be combined with the digital 

city. The digital city refers to cities that use geographical information systems (GIS), global positioning 

systems (GPS) or remote sensing techniques to construct the geographical information framework of a 

city. This information framework is the basis for public services throughout the city. The shortcoming 

of the digital city is that the information systems are rather simple and they do often not meet the 

practical needs of real-time updates and future prediction (Su et al, 2011). By combining the digital 

city with the Internet of Things significant value is added to the information framework of a static 

digital city. This value-added framework is the basic framework for the dynamic smart city.   
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3.3 Technology push vs. demand pull 
As mentioned in the previous section, the main difference between the Internet of Things and the 

smart city concept is that the former emerged from a technology push and the latter emerged from a 

demand pull. Demand pull refers to needs that may create a demand for new technologies or services. 

Technology push refers to rapid technological developments whereby new technologies or services 

spawn innovative uses (Kim et al, 2009). The smart city is thus a place where these two opposites 

meet. As reflected by recent smart city definitions, smart cities are nowadays making use of the new 

technological developments to tackle modern problems. If managed correctly these new 

developments can provide promising solutions to the existing problems. The main threat behind this 

development is however that technology push and demand pull move past each other. In other words, 

by focusing too much on implementing new technologies, such as sensors in this case, the real 

problems for which the sensors were being implemented can be overlooked. It is therefore of major 

importance that the problems, and the actual stakeholders who need a solution for these problems, 

are kept in mind during the process of sensor implementation and monitoring.  

 

3.4 Sensor vs. actuator 
The terms sensor and sensor network are used very often in combination with smart city initiatives. 

The terms are however rarely explained. A distinction should be made here between a sensor and an 

actuator. A wireless sensor network (WSN) consists of nodes, i.e. devices, “that can sense the 

environment and communicate the information gathered from the monitored field (…) through 

wireless links” (Verdone et al, 2008, p. 1). A wireless sensor actuator network (WSAN) also includes 

actuators. Actuators do not observe the environment, they manipulate it (Verdone et al, 2008). An 

actuator thus puts something in motion which can be a movement, light, sound or magnetism.  An 

actuator can for instance be a siren or an automatic gate. In the context of a smart city, actuators are 

often incorrectly referred to as sensors. Sensor networks in a smart city are often a combination of 

sensors and actuators. This research only takes the sensors into account, which will be further 

explained in section 4.3.3.   

 

3.5 Big data challenges 
Now that the framework for the smart city is founded, cities need to go to the next step as the 

number of smart initiatives is not necessarily an indicator of their performance (Neirotti et al, 2014). 

The data produced by smart cities can only be of value when it can be analysed and interpreted 

(Zaslavsky et al, 2012). The next step is therefore to manage, analyse and visualise the data produced 

by the smart city both efficiently and effectively. During this transition most of the problems arise and 

this is where the cities get stuck. Inseparable of the smart city is big data. The smart objects in a city 

produce a tremendous amount of data. Some key features of big data are that the data is huge in 

volume, high in velocity, diverse in variety, exhaustive in scope, fine-grained in resolution, relational in 

nature and flexible (Kitchin, 2014). The term big data has become a buzzword. There is a huge 

potential for decision support by the use of big data.  The underlying risk is however that big data is 

being produced without a specific purpose. It is not always about creating more and better data. In 

order to create real value for decision making the big data must be used as an input to specific 

analytics (Power, 2014), and this is not that easy.   
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There are several problems associated with big data. The main challenges lay in data capturing, 

storage, searching, sharing, analysis and visualisation (Chen & Zhang, 2014). Current software tools are 

not able to do this within a tolerable elapsed time (Wu et al, 2014). It is for instance useless to store 

the data if the knowledge cannot be retrieved or extracted efficiently. Therefore scalable data 

storages are needed (Zaslavsky et al, 2012). In many cases the knowledge extraction of data has to be 

very close to real-time. Otherwise it is nearly infeasible to store all observed data (Wu et al, 2014). The 

main problem concerning data analysis is that the data size is scaling much faster than the processor 

speeds. Therefore it is hard to analyse large volumes of data. The same problem is also present for 

data visualisation. The volumes and dimensions of data are often too high for current visualisation 

tools. The most data visualisation techniques are still focused on two dimensions while the data 

contains three or four dimensions. Also the response time is too low as most of the tools are not able 

to handle visualisation of real-time data (Chen & Zhang, 2014).  

  Furthermore, big data raises questions about data security and privacy issues. Sensors are 

typically wireless and such communication is made secure through encryption. However some of the 

sensors are currently not powerful enough to support robust encryption. In addition, security is 

important to ensure privacy. As more objects become traceable the personal privacy can be 

threatened. The ownership of big data must therefore be clearly defined, especially when the data is 

being shared throughout a platform (Whitmore et al, 2014).  

 

3.6 From data to wisdom: the DIKW pyramid  
When processing big data, it is important to make the distinction between data and information. Data 

is raw, which means that it is the direct measured value of for instance a sensor. This raw data can 

exist in any form, usable or not. Information arises when value is added to this raw data by ways of a 

relational connection or referential perspective. The difference between raw data and information is 

that information has a meaning. However, this meaning does not always have to be useful (Jifa & 

Lingling, 2014) and the boundary between data and information is often fuzzy. Therefore the widely 

known difference between data and information is extended into a more detailed hierarchy model, 

called the DIKW (Data, Information, Knowledge, Wisdom) pyramid.   

 

Several different terms exist for the DIKW pyramid. It is also referred to as ‘DIKW hierarchy’, ‘wisdom 

hierarchy’, ‘knowledge hierarchy’, ‘information hierarchy’ and ‘knowledge pyramid’ (Rowley, 2007). 

The DIKW pyramid is shown in figure 1. The pyramid contains two more levels besides the data and 

information level. Knowledge arises when expertise and skills are acquired through education and 

experience. Knowledge is especially useful for analysis, decision making and problem solving as the 

application of knowledge allows people to recognise situations similar to past situational patterns. It 

provides therefore the basis for future actions. When the level of wisdom is reached in the pyramid, 

people can derive a profound and deep understanding of key relationships and patterns that are 

critical to a certain activity. Wisdom thus extends knowledge with a higher level of cognitive 

processing (Conger & Probst, 2014). However, many academics do not refer to the wisdom layer 

(Rowley, 2007) and it will also not be further referred to in this research. 

  The main drawback of the representation of the model as a pyramid is that it suggests that 

higher levels are better or more preferred than lower levels. This is not always the case. The preferred 

level highly depends on the kind of data that is used, the users that need to interpret the data and the 

purpose for which the data should be used for. In some cases, it can even be sufficient to represent 
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data as raw data. For example, for a temperature sensor it might be enough to represent the raw 

data, i.e. the measured temperature value, directly. Before thinking about the preferred layer for data 

representation it is therefore very important to think about the data type, the associated visualisation 

possibilities, the final users and the purpose for which it is being used. It is for this research however 

of major importance that all representations together provide knowledge and understanding of the 

situation that can serve as a starting point for discussion and future actions. 

 

 
Figure 1: DIKW pyramid (adapted from Conger & Probst, 2014; Jifa & Lingling, 2014)   
 

3.7 The transition from 2D to 3D 
The previous section paid attention to the content level of data. However, no reference has been 

made to the number of dimensions that are used to represent the data. The standard is still to 

visualise data in only one or two dimensions. Until 2010 3D was something primarily discussed by 

academics (De Jong, 2014). Almost five years later, much has changed. For many academics 3D 

visualisation of geographical data is not new anymore. Their focus is now shifting towards the 

visualisation of 4D or 5D data. 4D visualisation includes the dimension of time. 5D visualisation also 

includes scale and makes it possible to smoothly zoom and generalise between different scales. Even 

the 6D level, where multiple themes are integrated, is currently getting attention. In the practical field, 

however, the transition from 2D to 3D data storage, analysis and visualisation is currently in full swing. 

Scholten (cited by Geonovum, 2014) argues that we are on the eve of a 3D geo-information 

revolution. The vast majority of governmental institutions in the Netherlands does not use 3D. The 

amount of 3D users is especially low among the municipalities (see figure 2). There is only one Dutch 

municipality that makes use of 3D conform the national IMGeo (Information Model Geography) 

standards (Van Rossem, 2014) for other purposes than a 3D city model. More governmental 

institutions, especially the bigger municipalities and provinces, are now making the step towards 3D 

geo-information (De Jong, 2014).  
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Figure 2: municipalities in the Netherlands that make use of 3D in January 2014 (adapted from Van Rossem, 2014)  

 

3D was previously seen as some extra tool to make fancy visualisations. Now it is demonstrated and 

realised more that 3D can add new value to information. With 3D analysis and visualisation, data can 

sometimes reach a higher level in the DIKW pyramid. Therefore, the use of 3D as a basis element for 

the geo-information framework has increased (De Jong, 2014). There is more data being captured in 

three or even more dimensions, especially with the advent of new smart sensors. If this data is being 

stored in only two dimensions it will lose detail and information. In addition, 2D visualisations of 3D or 

4D data are often cluttered. 

  Furthermore, 3D analyses and visualisations can contribute to better decision making as a 

decision support system (DSS). A decision support system is used to store, handle and process big data 

which serves as a basis for new decisions (Ortega et al, 2014). Such DSSs were originally based on 2D 

interfaces, however the third and fourth dimension are also getting more attention in this context. 

Decision support systems with 3D user interfaces have already proven to be effective for, among other 

domains, urban planning (Aldawood et al, 2014) and emergency management of public transport 

(Braun et al, 2012). This research will eventually show whether 3D information can also add value in 

the context of the living lab.   

 

3.8 Current practices 
This section describes the current practices concerning the visualisation of sensor data. It is based on a 

result of an academic literature study and more practical literature and material study. Visualisation of 

sensor data can be done in two ways. The first way is to visualise the sensor range. Thereby the spatial 

extent of a sensor is visualised. The sensor range thus shows the area in which the sensor is collecting 
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its measurements. The second way to visualise sensor data is to visualise the actual data collected by 

the sensor, e.g. degrees Celsius for a temperature sensor. Practices, by academics and practitioners, 

for both visualisation methods are explored in this section.  

 

3.8.1 SENSOR RANGE 
One of the ways to visualise the sensor range of for instance cameras is to use viewsheds and line of 

sights. A line of sight is visualises for a certain line whether areas are visible or not. A viewshed is the 

entire area that is visible from a given point, i.e. the viewing catchment area (VanHorn & Mosurinjohn, 

2010). Current GIS software packages are capable of creating these line of sights or viewsheds. The 

viewshed tool available in Esri’s ArcMap and ArcScene can create quick viewsheds based on default 

settings. It is also possible to include specific attributes, such as the azimuth, in the dataset to create 

more realistic visibility areas (Esri, 2014). The disadvantage of using viewsheds is that they are not 

capable of dealing with camera specifications such as the focal length that highly influences the field 

of view. Furthermore they are only able of taking raster layers into account so for instance feature 

classes cannot be used to determine the height.  

Camera brand Axis created a free extension for SketchUp to model cameras and their field of views 

(FoV) in three dimensions. SketchUp is an open source 3D CAD software used to create building plans 

and architectural designs. The Axis camera extension for Google SketchUp enables people to include 

Axis network cameras in the building plan. Furthermore the field of view for each camera type can be 

calculated. In addition, a scene can be created where the view from the camera can be investigated. 

The camera settings are interactive so it is possible to play with settings such as the tilt angle or the 

focal length to set the desired field of view (Axis, 2014). The cons of this extension are however that it 

is primarily focused on Axis cameras and that the SketchUp software is not directly related to a 

reference system. In addition, the extension is mainly used to model cameras in building plans and not 

to model already existing cameras. As it is possible to interactively play with the settings of the 

standard Axis camera models, the specifications could be adjusted for the camera specifications in 

Eindhoven. Furthermore a conversion with geo software is needed to make sure that the camera 

locations are positioned on the right coordinates.  

  

Geodan is working on an algorithm to model camera field of views in both two and three dimensions. 

This algorithm is created using a programming interface on top of the Unity gaming software. Just like 

the SketchUp extension this algorithm takes specifications like the focal length of the camera, tilt 

angle and azimuth into account to model the field of view. Besides the creation of a field of view this 

algorithm models furthermore the different recognition areas within a field of view based on pixel 

density (see figure 3). These different areas are identification, recognition and observation. In the 

identification area of the field of view it is possible to identify for instance number plates or faces. In 

the recognition area it is still possible to recognise people or number plates however no faces or 

numbers can be identified. In the observation area objects can be observed but not recognised. These 

areas are however less relevant for this research since the camera sensors in Stratumseind are only 

used to observe the number of people, the cameras are thus not used for facial recognition. The 

algorithm is not finished yet. Therefore the tool can be used, but the need of some additional steps to 

adjust the angles of the field of view.  
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Figure 3: field of view areas: identification, recognition and observation  

No studies or articles have been found where the sensor range of 3D microphones has been 

visualised. The range of 3D microphones is however less advanced as the sensor measures in all 

directions and thus it could be visualised as a circle around the sensor. Furthermore, the 3D 

microphones as used in Eindhoven do not have a fixed range which makes a visualisation of the sensor 

range irrelevant.  

 

3.8.2 SENSOR VALUES 
A sensor is a really wide concept as many things can be referred to as sensors. There is no one-fits-all 

visualisation method that can be used for all kinds of sensors and not much is being written and 

explored so far about three dimensional visualisation methods of sensor data. Helbig et al (2014) 

describe in their article how they visualised atmospheric sensor data in three dimensions. They did this 

by using commercial virtual reality software VRED from AutoDesk. They make an important distinction 

between 3D vector data (e.g. wind) and 3D scalar data (e.g. humidity). This data type determines also 

what kind of visualisation method is used. For instance colour, opacity and shape can be used to 

represent data. For scalar data, they used slices (humidity), iso surfaces (elevation) and iso volumes 

(clouds) to visualise the data. 3D vector data, in this case wind, also includes attributes as direction 

and time in the visualisation however this data type is less relevant for this research (Helbig et al, 

2014).  

  The main downside of the sensor data visualisations by Helbig et al with respect to this 

research is that for instance within or between volumes, no colour gradations are shown. Stellmach et 

al (2010) use eye-tracking data and different colours to visualise gaze intensity in three dimensions. 

They make a distinction between three types of visualisation: projected, object-based and surface-

based. The projected view is a 2D representation of 3D data and it is therefore not further described 

here. The object-based visualisation makes a distinction between 3D objects based on different 

colours for each object. This allows for quick evaluating of the situation. A more detailed method is 

that of surface-based visualisation.  This method uses colour gradations within an object (Stellmach et 

al, 2010). In the context of eye-tracking the object-based method thus shows which object is viewed 

most whether the surface-based method also shows which locations on a certain object are viewed 

most. Maurus et al (2014) used this latter approach to create 3D volumes representing heat maps of 

gaze data. They do however not state which software is used to create the heat maps. In the context 

of eye-tracking the gaze dataset contains dozens of points to create a heat map from. It is however 

also possible to create something similar as a heat map with less data. For instance in the context of 

noise the data measured by the sensor can be combined with general rules about the decrease of 

noise over a certain distance to create a more detailed visualisation overview of the available noise.
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An important aspect when modelling sensor values is the dimension of time. Many sensors produce 

real-time values with very short intervals of only a few seconds. A decision thus has to be made 

whether sensor values are represented real-time or afterwards, i.e. post-processed. The advantage of 

real-time data visualisation is that immediate actions can be taken or decision can be made based on 

an observed pattern. Real-time data visualisations are however a rather new development which is 

currently especially focused on two dimensional visualisations. Benedek (2014) proposed an approach 

for real-time 3D people surveillance however this approach is established for special range sensors 

that are not available in Stratumseind.  

In addition, sensor value visualisations can be combined with 3D geo-fences. Geo-fencing is the 

process whereby a virtual perimeter is created to represent a geographic area in the real world. 

Virtual fences are thus created to track for instance whether an object enters or exits the virtual area 

(Li et al, 2013). The technique of geo-fencing is currently applied in several domains such as wildlife 

monitoring, advertisement and media recommendations (Pongpaichet et al, 2013). These applications 

make use of 2D geo-fencing. It is however also possible to create 3D geo-fences. This could be very 

useful to determine legal flight areas for drones for instance. Geo-fencing of legal zones can also be of 

added value in the context of sensor data visualisation. For instance virtual zones concerning noise 

legislation can be added to maintain the noise standards at different timestamps.   

 

3.9 Conceptual model  
This section contains the conceptual model (figure 4) of the position of the research, and specifically 

the case study, within its context. The model gives a graphical impression of how the underlying 

concepts, as explained in this chapter, are related to each other. The model is an outcome of this 

chapter in combination with the problem statement. Furthermore it provides a first impression of the 

used methods.  
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Figure 4: conceptual model  
 

3.10 Conclusions 
This chapter showed that many different definitions of the smart city exist that developed over the 

years. Recent definitions focus on the use of smart technologies to tackle modern problems. Smart 

cities, and the sensor networks in smart cities, produce tremendous amounts of data. In the 

meantime, a transition from 2D to 3D geo-information is going on. These recent developments, i.e. 

the rise of sensor networks and big data and the increasing importance of 3D geo-information, form 

the basis for new challenges concerning data visualisation and analysis experienced by smart cities. 

The rate at which these developments are taking place does also threaten the needs of the 

stakeholders.  

  Furthermore, this chapter provided an answer to the first sub question: “What has been done 

already, both by academics and practitioners, concerning 3D+time visualisation of geographical sensor 

data?” The overall conclusion that can be made about this question is that not much has been done 
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concerning the combination of smart cities, sensors and 3D GIS. While some tools are available for the 

visualisation of camera field of views, there is not yet a fully operational tool that can be used in 

combination with a 3D city model. Also regarding the visualisation of sensor values not much has been 

done. It is also hard as there are many different sensors and each type of sensor might require their 

own optimal visualisation method. Atmospheric sensor data is probably developed most as it comes to 

3D visualisation. However these sensors are less relevant for this research as there are no atmospheric 

sensors included here.  
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4 METHODOLOGY 
 

This chapter describes the methods that will be used to carry out this research. The chapter consists of 

the following sections: 

 

 4.1 – Approach and methods: explains the two main methods of user experience design and 

data mining that are a result of the exploratory research approach. It also motivates why 

these two methods are suitable during this research. 

 4.2 – The process: describes the entire research process. It also explains how and where the 

methods of the previous sections are applied in the process. 

 4.3 – Further justification: justifies the choices for all other, besides the choice for the two 

main methods, aspects of the research.  

 4.4 – Data: describes the data that is available for this research. Furthermore it explains from 

which sources the data originated 

 4.5 – Software: addresses the software that will be used to carry out the research. 

 4.6 – Set up of experiments: explains the experiments that will be used during this research to 

answer the sub questions.   

 

4.1 Approach & methods 
As not much is known about how to visualise 3D data and sensor data in one environment, this 

research has an exploratory character. At the same time, the research has also a descriptive character 

as the output should describe the current situation, e.g. with respect to camera coverage, in the living 

lab area. The explorative approach is however the leading approach to determine the main methods 

used during this research: user experience design and data mining. These methods will be explained in 

more detail in the next sections.   

 

4.1.1 USER EXPERIENCE DESIGN  
The article by The Guardian, cited in the introduction of this research, already showed that it is crucial 

to engage citizens in a smart city. Otherwise most initiatives will be only nice experiments. User 

experience design is one of the main methods for this research as it includes the needs of the users 

throughout the entire process. It does not only include the users during the research process, but the 

user profiles can also be used during the process of future actions related to the area. This research is 

part of the initial phase of one the one hand the ongoing developments in smart cities with respect to 

sensors and 3D geo-information and on the other hand the specific Stratumseind 2.0 project. The 

entire project process in which the stakeholders are relevant goes beyond the scope of this research.

   

The main objective of almost every visualisation is that the final users should be able to understand 

and interpret it. It is therefore of major importance to include the stakeholders, which are the end 

users, in this research process on visualisation of sensor data. The user-centred design approach is an 

accepted method of doing this. However, the user experience is often overlooked in user-centred 

design. User experience is defined by Garrett (2011, p. 6) as “the experience the product creates for 

the people who use it in the real world”. User experience pays attention to how things work, not on 

the inside but related to its context. For instance in the case of technology often a lot of capabilities 
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are pushed which makes it unnecessarily hard to do the easy things. When relating this to the DIKW 

pyramid, the inclusion of user experience can enable the step between information and knowledge.

 An important aspect of user experience design is the creation of personas, also referred to as 

user profiles or user models. A persona is a fictional character that represents the needs of a group of 

real users (Garrett, 2011). The creation of personas is especially useful when dealing with diverse 

users (Matthews et al, 2012) as is the case for the decision makers of Stratumseind. All kinds of data 

can be collected about these different personas. Both individual characteristics, e.g. gender and 

education, but also contextual characteristics. For instance it can matter whether a person has to use 

the product during daytime or during the night, or whether the product is used indoor or outdoor. The 

main risk of collecting all this information about characteristics is that the real people behind the 

statistics are being overlooked. The fictional characters should ensure people that the users are kept 

in mind during the entire design process (Garrett, 2011). Section 4.2 will explain how user experience 

is included in this process.  

 

4.1.2 DATA MINING 
The databases available for this research containing all the sensor data, explained in more detail in 

section 4.4, are very voluminous. To get an insight in the information that is inside this database, some 

kind of exploration technique is needed. This is the basis for the motivation to use data mining as a 

main method during this research. Furthermore, data mining has already proven to be effective in an 

exploratory context. 

Data mining is “the science of extracting useful knowledge from (…) huge data repositories” 

(Chakrabarti et al, 2006, p. 1). The goal of data mining is to obtain understandable and useful 

information (knowledge) from big data in order to use this information for further actions. Data 

mining is therefore seen as a central analysis step of the knowledge discovery in databases (KDD) 

process (Fayyad et al, 1996). A more specific definition of data mining was given by Larose & Larose 

(2014, p. 2) who define it as “the process of discovering useful patterns and trends in large datasets”.  

The focus on this research is especially on the former definition. Figure 5 clarifies the entire process of 

knowledge discovery and the position of data mining within this process.  

  The emphasis within the knowledge discovery process in this research is on visualisation, 

which is part of the data mining phase. For data mining to be effective, the general knowledge, 

creativity and flexibility of a human should be combined with the storage capacity and computational 

powers of a computer. Visual data exploration aims to combine these two elements. The basic idea 

behind this is to represent data in some visual form that allows people to get insight into information 

derived from the data, draw conclusions and interact with the data. Especially in exploratory data 

analysis these visual data mining techniques have proven to be highly potential (Keim, 2002). Data 

mining is therefore of major importance during this research.   

 

Figure 5 might arouse the wrong suggestion that knowledge discovery is a linear process. However, 

data mining is an iterative process. The data is studied and examined, it is used with some analytical 

technique and it may be decided to look at it again from another point of view. The process then starts 

again and for instance another analysis technique is used until the desired or best results are reached 

(Kantardzic, 2011). Besides iterative, it is also crucial for the data mining process to be interactive. In 

traditional data mining processes algorithms provided insight in lots of patterns, however many of 
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these patterns were not interesting for the final user (Goethals et al, 2011). By combining the methods 

data mining and user experience design in this research this problem should be overcome or reduced. 

 

Figure 5: position of Data Mining within the Knowledge Discovery p rocess (adapted from Bramer, 2013; Kamath, 2014)  

 

4.2 Methods applied to the process 
As mentioned before, this research is structured based on five sub questions. This section will explain 

how the above methods and approaches are applied to each sub question. As the research has an 

exploratory character, the process is iterative. This means that methods can be adapted or changed 

and that new methods can emerge later on in the research process.   

 

The first sub question is: “What has been done already, both by academics and practitioners, 

concerning 3D+time visualisation of geographical sensor data?”. This research question was already 

answered in chapter 3. All other sub questions are applied to the case: Living Lab Stratumseind 2.0. 

The case study exists of two different parts. The first part is the examination and improvement of 

sensor data supply versus stakeholder demand with the use of 3D GIS. This part consists of research 

questions 2 till 4. The second part is the visualisation of camera field of views and this is included in 

research question 5.  

 

4.2.1 CASE STUDY PART I 
The second sub question is: “Who are the stakeholders of smart sensor data and what requirements 

do they have concerning sensor information and visualisation?”. This question addresses the target 

group for whom the final visualisations should be understandable and interpretable. A clear definition 

of the target group will be established, which can consist of different types of persons. Besides, the 

purposes for which the stakeholders want to use the sensor data should be examined. This is the 

phase where the user experience design method is applied. Qualitative research will be used to collect 

information about these stakeholders. Interviews will be held with several representatives of personas 

to examine the requirements they have concerning the sensor data in general and the visualisation 

and analysis capabilities of the sensor data. The next section (paragraphs 4.3.1 and 4.3.2) will further 

justify the choice for interviewees and the structure of the interview. The interviews should in the end 

be used as input for the creation of user profiles. These user profiles, or personas, will provide a 

summary of the most important characteristics and requirements of all stakeholders.   
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As explained in the background, smart cities are facing the challenge to overlook real problems when 

technology is being pushed. It is therefore of importance to investigate to what extent the availability 

of data is aligned with the requirements of the stakeholders. This investigation is a result of sub 

question 3: “To what extent do these requirements match the current availability of information?”. The 

match between sensor data supply and stakeholder demand will be examined based on a comparison 

between on the one hand the availability of data (section 4.4) and on the other hand the requirements 

derived from the interviews and user profiles. This comparison leads to the answer to the third sub 

question.  

  The fourth sub question is: “How can 3D GIS contribute to a better alignment of data supply 

and stakeholder demand?”. As part of this question it will be explored to what extent 3D GIS and a 3D 

city model can be used to (1) increase the information level of the sensor data and (2) to better align 

the sensor data supply and stakeholder demand. This will be done by exploring the data and 

visualising some aspects of the data within a 3D city model. The data mining method, and specifically 

visual data exploration, is very important here. Especially the 3D microphones produce huge 

databases. Without some sort of visualisation it is extremely hard to derive any information from this 

database. By testing the possibilities of 3D GIS with respect to the available data the opportunities for 

3D GIS, both in terms of the information level and in terms of the alignment between data supply and 

stakeholder demand, will be explored. These possibilities will not just be tested out of nowhere, but 

they will be based on the findings of the interviews and the answer to the previous sub question. The 

information gathered earlier during the research process is therefore an important starting point for 

this sub question. Furthermore a roadmap will be created for the successful test cases. This roadmap 

will be included in the appendix of this research and it can be used to reproduce the results. If 

possible, the aim is to construct a model to automate the process and to make it even easier to repeat 

all steps.   

 

4.2.2 CASE STUDY PART II 
The second part of the case study includes the visualisation of sensor range. This part of the research 

answers the final sub question: “How can 3D GIS be used to visualise the spatial extent of sensors?”. 

During this phase software is used to model the location and range of the sensors within the existing 

3D city model. This part will not address the visualisation of data collected by the sensor, but more so 

a visualisation of the data about the sensor. Technical details about the sensor are essential to be able 

to visualise these data. Paragraph 4.3.3 will further elaborate upon the relevance for this kind of 

visualisation for the different sensors. The way this part of the research will be methodologically 

completed is highly dependent on the findings of the first sub question. Based on these findings, the 

appropriate software will be chosen and one or more methods can be explored. Just as for the fourth 

sub question a roadmap will be created to be able to repeat the steps needed to reach the final 

visualisation. For the sake of time reasons the goal of this case study part is just to visualise the spatial 

extent of sensors that can be used to inform inhabitants and stakeholders of the smart city about the 

situation regarding the sensor coverage (see section 2.3).  

Figure 6 shows a schematic visualisation and summary of the entire research process. The figure 

shows furthermore which research step belongs to which sub question and where in the report the 

different methodological steps will be elaborated.  
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Figure 6: methodology process 
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4.3 Further justification 
Besides the choice for the aforementioned methods of user experience design and data mining there 

are also other choices involved. This section therefore explains the reasons behind the choices for the 

interviewees, the structure of the interview itself, the sensors and the use of a case study.  

 

4.3.1 INTERVIEWEES 
Four different target groups are distinguished as part of this research. The requirements of these 

target groups will be retrieved via interviews. A total of four interviews will be conducted during this 

research. Each interview is held with a representative of one of the target groups.    

  The first interviewee is an inhabitant of the Stratumseind area. He is also the chairman of the 

Stratumseind inhabitant platform. The inhabitant platform participates in the general quality 

considerations of Stratumseind. Furthermore there is a recurrent consultation only for inhabitants. As 

the chairman of this platform he has a quite extensive overview of the overall requirements of 

inhabitants concerning the (visualisation of) sensor data.   

  The second interviewee is a pub owner in the area of Stratumseind. In the past he has been 

the chairman of the Stratumseind pub association. Currently he is one of the spokesmen of the pub 

association within the more general quality considerations. During these quality considerations he 

already represents the needs and desires of the pub owners.  

  The third interviewee is working for the police in Eindhoven. Currently there is a 

reorganisation going on but his function is what was previously being called networker regarding the 

hospitality industry. Therefore he functions as an intermediary between on the one hand the police 

and on the other hand involved parties such as pub owners, doormen, breweries, the municipality et 

cetera. With Stratumseind as the most well-known hospitality area of Eindhoven, he has an extensive 

knowledge of both the situation in Stratumseind and the requirements of the police.   

  The final interviewee is a property owner of several business properties and apartments in 

Stratumseind. Unlike the other target groups, the property owners do not have their own 

Stratumseind platform. They are however part of the more general quality considerations. For the 

property owners it is therefore a bit harder to get insight in the requirements of the entire target 

group. There are quite some property owners involved in the area however the majority of the 

properties is owned by only a small amount of owners. This interviewee is one of these few property 

owners. He is also the direct contact with the Stratumseind 2.0 project organisation.   

 

4.3.2 INTERVIEW 
The interviews should provide insight in the alignment of data supply and stakeholder demand. The 

interviews should therefore retrieve information about the purposes for which stakeholders want to 

use sensor data and about the requirements they have to retrieve information from this sensor data. 

As the Living Lab project is rather new it could be hard for the interviewees to express their needs. The 

findings of section 3.8 will be processed in the interview questions used to define the requirements. 

By doing so, the questions are being made more concrete which makes it easier for the interviewed 

person to express their needs. An additional advantage of this is that these concrete needs are easier 

to compare with the current availability of sensor data. To overcome the problem that interviewees 

only think in terms of the examples, the interview will start with more general open questions to 

determine the first needs if there are any. The interview thus has a funnel structure.   
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4.3.3 SENSORS 
The study area has a broad scope of sensors that will be explained in more detail in the next section. 

Because of the limited time it is not possible to include all sensors in this research. Besides, 3D GIS is 

not relevant for all sensors. This latter reason is decisive for the determination of sensors that will be 

included in this research. For instance, origin sensors can track the location where visitors come from. 

The result of this can be a two dimensional map but 3D visualisation is not relevant for this particular 

example. The sensors that will be included in this research are the people counting cameras and the 

3D microphones. For the people counting cameras, 3D information can be relevant for the 

visualisation of field of views. Camera field of views are three dimensional virtual areas that show the 

viewing field of a camera. If these areas are visualised in only two dimensions, information will be lost. 

A field of view is also highly dependent on objects that remove areas from the field of view. 

Furthermore the municipality requires a sensor range visualisation of these cameras for information 

and visualisation purposes in the living lab. For the actual data measured by the people counting 

cameras, i.e. the amount of people entering or leaving Stratumseind, 3D visualisation is not relevant as 

the data does not contain three dimensions. In contrast, for 3D microphones 3D visualisation of 

measured data is much more relevant than 3D visualisation of sensor range. Sensor range for 3D 

microphones could be visualised as 3D spheres. However the 3D microphones do not have a fixed 

range. 3D GIS has more potential for visualisation of sensor values as 3D GIS can provide better insight 

in the location of noise sources. For instance, a 2D visualisation of 3D microphone data does not show 

the exact noise source when a building has several floors and owners.    

 

4.3.4 CASE STUDY 
Living Lab Stratumseind 2.0 is located in the Dutch smart city Eindhoven. Stratumseind is the bar 

district of this city and it is one of the best known bar districts of the Netherlands. However the past 

few years the amount of brawls has risen, the amount of party people has decreased and more 

buildings are getting neglected (Omroep Brabant, 2014). The municipality wants to bring back the 

good atmosphere and that it why they chose to make Stratumseind a living lab. The goal of this living 

lab is to structurally improve the economic and social function of the area together with involved 

parties such as pub owners, the police, inhabitants, breweries, property owners et cetera. Several 

times a year a meeting is planned with all these parties to establish an action plan for Stratumseind 

and to discuss the state of affairs. The structural improvement of the area is focused on safety, 

liveability and attractiveness (Kanters, 2013). Furthermore this living lab serves as a business model 

with 12 goals: 

 More visitors  Cut down on energy costs 

 Longer visitor stay  Cut down on security costs 

 Bigger spending per person  Cut down on cleaning/waste costs 

 Less vandalism costs  Increase of real estate value 

 Less police costs  Increase of earnings 

 Less health costs  Direct marketing 

  

This living lab is a perfect experimental environment where new technologies can be tested. 

Stratumseind thus serves as a test area for different kinds of sensors. Currently, there are 7 different 

types of sensors or actuators installed in the Stratumseind area. These include: 
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 Temperature sensors: measures the temperature recorded in Celsius, but also the wind 

direction and the rainfall in millimetres per hour  

 People counting cameras: flexible public security cameras integrated with ViNotion software 

to identify and count people entering or leaving the camera field of view  

 2D and 3D microphones: measure the sound level at a certain location. The 3D microphones 

furthermore, with the aid of MuniSense software, include information about the origin 

locations where the noise is coming from 

 Origin sensors: in collaboration with mobile data from Vodafone these sensors can detect the 

cities or towns where visitors of Stratumseind live 

 Social media detection: word recognition software detects whether Tweets sent about the 

Stratumseind area are positive, negative or neutral 

 Smart lighting: specifically designed street lights by Philips that have the ability to mix neutral 

light colours, such as white and yellow, with other colours to determine the atmosphere. 

 Mac readers: these sensors have the ability to read mac addresses of devices, such as cell 

phones. These sensors can be used to indicate the people density in the area.  

It is chosen to use a case study to conduct this research for several reasons. A case study is needed to 

make the research more specific. Chapter 3 already showed that there are many different sensors and 

that there is no one-fits-all visualisation or analysis method. The case study provides a demarcation for 

the study and the (data of the) kind of sensors that are being explored. Furthermore, a case study can 

help explore whether some analysis method is useful in practice. By testing methods for a case, it can 

be investigated whether these methods can be more generally applied.  

  The decision to use the project Living Lab Stratumseind 2.0 as the case study is based on the 

fact that most of the underlying developments and challenges, as described in chapter 3, are 

experienced in this project. Eindhoven is a progressive and innovative city in the Netherlands, both 

with respect to their sensor network and their ambition to create added value with 3D information. 

According to the literature study it is likely that other cities will make use of similar technologies in the 

near future.  

 

4.4 Data 
The data used for this research is coming from a variety of sources. Most sensor data of Stratumseind 

is stored in a central Amazon database. This database contains a metadata table and a table for the 

actual measurements. However this database will not be used for several reasons. The first reason is 

that the data from the people counting cameras, as mentioned in section 4.3.3, is not relevant for 3D 

visualisation.  The second reason is that the data of the 3D microphones is the only data that is not 

included in this database. This next sections provide more details about the sources from which the 

data is obtained and the way in which the data is established.   

 

4.4.1 3D MICROPHONES 
The 3D microphones are sensors that contain four or five microphones to be able to measure sound in 

three dimensions. The sensor collects its measurements on a real-time basis. The interval for this real-

time information is only 1 second. This means that if the value changes, every second a new record is 

added to the table. The data measured by the 3D microphones should be obtained through a specific 

portal from Munisense. Munisense is the supplier company of these sensors. The portal contains both 
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viewing and export capabilities. The current view is however a two dimensional view (see figure 8). 

The portal furthermore has some query options to show data of a particular timeframe or to create a 

specific database export. It is not possible to export the entire database as the export function has its 

limitations. The sound measurements points that can be exported have a total of 40 attributes. It 

however contains a lot of attributes that show the average of a specific measurement over a certain 

period. For the purpose of this research, especially the following attributes are relevant: date and 

time, LAeq, azimuth, elevation, longitude and latitude. Some attributes, such as the date and time, are 

straightforward but others need more explanation. The LAeq is the equivalent A-weighted noise level. 

A-weighted means that it takes into account the sensitivity to the pitch of a human ear. The unit of the 

LAeq is thus dB(A) which is more commonly known. The azimuth is measured in degrees with respect 

to the north. The elevation attribute is somewhat misleading. The most obvious is that elevation is 

given in a unit like meters. However, the elevation attribute is stated in degrees. What is called 

elevation in the Munisense database is often referred to as the vertical angle. It thus represents the 

vertical direction from which noise is measured.  

  The latitude and longitude are not the coordinates of the sensor itself, but the coordinates of 

the noise sources. Therefore, they are very important as they show the actual locations from which 

noise is being measured. Figure 7 helps illustrate the way these coordinates are being determined. A 

sensor is for instance attached to a pole at a certain height. The X, Y and Z coordinates of this sensor 

are known. Furthermore, each measurement contains an azimuth and elevation (or vertical angle) that 

indicate the direction from which the noise is coming. Based on these two angles, a linear line is being 

drawn until it intersects the source height line. Munisense currently uses a source height of 150 

centimetres in Stratumseind. This source height is based on the assumption that noise is created by 

people and that these people are approximately 150 centimetres above the ground level. Another 

possibility is that the vertical angle is between 0 and 90 degrees. In this case a never ending line can 

be drawn as it will never reach the source height. All incoming sound with a vertical angle between 0 

and 90 is therefore classified as air sound and it is not further taken into account. 

 

Figure 7: noise source determination method 

 

Figure 8 shows the current visualisation of the 3D microphones. It is an aerial photo with a real-time 

two dimensional visualisation of the noise sources. It represents what the noise source determination 

method described above looks like in a visualisation with some example data. The colours of the noise 

sources reflect the amount of noise measured. All noise sources are connected to the sensor location 

with lines. This 2D visualisation is part of the Munisense portal and the visualisation changes real-time.   
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Figure 8: current visualisation of 3D microphones  
 

4.4.2 CAMERAS 
The people counting cameras are normal cameras enhanced by smart software to recognise, detect 

and track people. The software combined with the camera is therefore able to count the amount of 

visitors entering or leaving the area. For the cameras it is very important to know the camera brand 

and the specific model type to obtain information about the camera specifications. The people 

counting cameras in Stratumseind are all Bosch Flexidome HD 720p VR IVA cameras. This information 

is derived from Tele-event, the company that is responsible for all operational issues concerning the 

sensors in Stratumseind. With this information about the camera type, the specifications of the 

camera can easily be found via Google or via the Bosch website. Especially the focal length is 

important as it determines the width of the field of view. Furthermore, information about the 

resolution of the camera is needed when different recognition areas (see section 3.8) are 

distinguished.   

  At least as important as the focal length is information about the position of the camera. Not 

only the X, Y and Z coordinates are important but also the viewing angles. The first important angle is 

the azimuth, which is the angle with respect to the north. This angle determines the horizontal viewing 

direction of the camera. The second important angle is the vertical angle, also called tilt angle. This 

angle determines the vertical viewing direction of the camera. Information about these two angles is 

not available for the cameras in Stratumseind. Appendix IV explains how assumptions can be made 

about these angles.   
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4.4.3 OTHER 
Other important data used for this research are the coordinates of the sensors and the 3D city model. 

The coordinates of the sensors itself are included in the OpenRemote sensor database. However, the 

height coordinate is missing here. Therefore the XYZ location in the Dutch RD projection system are 

derived from the surveyors of the municipality. They used Cyclomedia’s GlobeSpotter to determine 

the coordinates of the sensors. The accuracy of coordinates is approximately 10 centimetres which is 

sufficient for the purposes of this research.   

  The 3D city model is supplied by the geo-information department of the municipality. It is 

available in several data formats, e.g. KML, FGDB, Microstation and 3D CityGML. Especially the File 

Geodatabase format is very useful for this research. It is however not directly ready to use. Appendix 

IV explains the steps that must be taken to correctly represent the city model in ArcGIS. The city 

model however still contains errors concerning geometry. However, as described in section 2.3, it is 

beyond the scope of this research to repair these errors.   

 

4.5 Software 
As this research focuses mainly on the visualisation of geo-information in three dimensions, software 

capable of dealing with this information will be used. Especially Esri’s ArcScene will be used as the 

current 3D city model is also available in Esri formats. Furthermore, CityEngine will be used to create a 

webscene of (some of) the final results. Esri software is used because it is also used within the 

municipality of Eindhoven. Esri recently developed new tools capable of dealing with 3D data. 

However recent practices at the Dutch company Geodan showed that gaming software, e.g. Unity, has 

sometimes more advanced possibilities concerning 3D analysis and visualisation. Therefore the 

potentials of gaming software to model the sensor coverage will be studied in collaboration with 

Geodan. The Unity scripts can then be translated to ArcGIS toolboxes for instance to use GIS software 

for final visualisations. Section 3.8 also showed that SketchUp might be useful for FoV visualisation. 

One of the experiments (see next section) will therefore also make use of the SketchUp software.  

 

4.6 Set up of experiments 
This section explains the experiments needed to answer the research questions. The section is divided 

by two different research parts that can be distinguished during this research. Part I describes the 

experiments that are related to the first part of the research which focuses on the alignment between 

sensor data supply and stakeholder demand. Part II describes the experiments related to the second 

part of the research which focuses on the 3D visualisation of camera field of views.    

 

4.6.1 PART I: STAKEHOLDER DEMAND VS. SENSOR DATA AVAILABILITY 
A lot of people are involved or concerned with the living lab. It is therefore important to define a 

target group for whom the final visualisations should be understandable and interpretable to serve as 

a basis for decisions. The definition of the target group of this research is defined as all people 

concerned with Stratumseind who are directly, together with the municipality of Eindhoven, involved 

in the decision making process about the area and who require 3D noise or people counting sensor 

data to stimulate better decisions.  
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This definition excludes certain groups from the target group. Visitors of the Stratumseind area and 

general inhabitants of Eindhoven are not considered target people as they are not directly involved in 

the decision making process of the area. Furthermore, sensor suppliers, pub catering suppliers and 

other partnering institutions (such as universities) are with this definition also excluded as they have 

do not directly require this sensor data. The remaining groups are therefore: the police, the 

inhabitants of Stratumseind or the direct environment, pub owners and property owners.  

The decision to include these stakeholders in this research is based on the fact that all of them are in 

direct contact with the municipality about the Stratumseind 2.0 project. Furthermore all of these four 

groups do require sensor data for some kind of purpose to support better decision making. Based on 

these two aspects these stakeholders fall within the definition of the target group. 

The definition described above is the basis for the experiment concerning sensor data supply and 

stakeholder demand. Interviews are conducted with one person from each target group to investigate 

the needs of the stakeholders. The processed interviews are summarised in personas or user profiles. 

These personas are then compared to the findings of section 4.4 to examine whether the 

requirements of the stakeholders as derived from the interviews are in line with the data availability. 

The comparison leads to an overview of the 3D GIS opportunities. Based on these opportunities it can 

be determined which software or tools can help to stimulate a better alignment of data supply and 

stakeholder demand. At least one experiment with 3D GIS should unveil whether an opportunity for 

3D GIS does create added value. It is important to examine the difference of either including or not 

including 3D GIS to review the possible added value of 3D geo-information.  

 

4.6.2 PART II: FOV VISUALISATION 
The second part of the research focuses on the visualisation of field of views (FoV). A visualisation of 

several field of views can give a fast overview of the camera coverage in the area. Furthermore it can 

also be used to determine an optimal position for new cameras. A distinction should be made here 

between an actual and a potential FoV. The potential FoV is the area that can be potentially seen from 

a camera location. The actual FoV is the area that is visible from the camera at one specific moment. A 

potential FoV is relevant for dome cameras as the FoV is highly dependent on the settings of the 

camera on a specific moment. The cameras in Stratumseind are also dome cameras. However the 

cameras are used to count the number of visitors and therefore the camera will always be directed to 

the same area of a street entrance which makes its potential FoV irrelevant.   

This second part of the research consists of two experiments. The main difference between these 

experiments is that two different tools are used to create the FoVs. The first experiment makes use of 

the Axis plugin in combination with SketchUp software. The second experiment uses the Geodan 

toolbox to create the FoVs. The Geodan algorithm is able to visualise different recognition areas based 

on pixel density. However, these are not relevant for this research so only the observation field of 

view, which consists of the entire FoV, will be visualised. Geodan created an ArcGIS toolbox from the 

algorithm to construct the FoV in ArcGIS. For both tools it will be examined what the advantages and 

disadvantages are in terms of user-friendliness, accuracy, integration into a city model and 

visualisation.  
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5 RESULTS AND FINDINGS 
 

This chapter discusses the results and findings derived from the experiments described in the previuos 

chapter. This chapter is again divided by the two research parts and it consists of the following 

sections: 

 5.1 – Part I: stakeholder demand vs. sensor data availability: describes the results and findings 

related to the first part of the research that focuses on the alignment between sensor data 

availability and stakeholder demand. It also provides an answer to sub questions 2 till 4. 

 5.2 – Part II: FoV visualisation: describe the experiments that relate to the second part of the 

research which focuses on the 3D visualisation of camera field of views. The section provides 

an answer to sub question 5. 

 5.3 – Webscene: provides a link to the online webscene that contains an overview of some 

results. 

 5.4 – Discussion: contains the discussion points that should be taken into account when 

interpreting the results and findings of this chapter.  

 

5.1 Part I: stakeholder demand vs. sensor data availability 
This section describes the results and findings from the experiments that relate to the first part of the 

research. The first section focuses on the findings derived from the interviews with stakeholders. The 

second section described the results from a comparison between the interview findings and the 

availability of sensor data. The final section explains the results from the 3D GIS analyses to better 

align stakeholder demand and sensor data supply.   

 

5.1.1 STAKEHOLDER REQUIREMENTS & PERSONAS 
The requirements of the target group are defined based on interviews with several different 

stakeholders. Each interviewee represented one of the target groups stated in section 4.6.1. The full 

interviews, although held in Dutch, can be examined in appendix III. This section provides an overview 

of the most important requirements that emerged from the interviews.   

 

The first interview is held with an inhabitant of Stratumseind. This interviewee is also the chairman of 

the Stratumseind inhabitant platform. The main goal of the inhabitants is to check whether their noise 

complaints are valid. As the chairman of the inhabitant platform, he is getting a lot of noise complaints 

from other inhabitants. Perception is however of major importance here. For instance a head ache or 

music taste can influence this perception.  It could then be the case that people are complaining while 

the pubs stay within their limits concerning noise. It is therefore important for the inhabitants to check 

at a glance whether a certain noise complaint is righteous. As the age and education level varies 

greatly among inhabitants, the visualisation should be very simple. Everyone should be able to 

interpret the situation. Therefore they require a visualisation with a maximum of three colours, by 

preference green, yellow and red, to indicate the situation. Noise regulations should serve as a basis 

for this visualisation. The visualisation environment should furthermore look as realistic as possible. 

When buildings are visualised realistically, the inhabitants can identify from which pub the noise is 

coming from as not all of the inhabitants are familiar with the pub names. Finally, the inhabitants 

require short interval real-time access to sensor data to see whether the data confirms their 
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perception of nuisance. For post-processed data it is enough to retrieve data of up to three days 

before.   

  The second interviewee is a pub owner and the former chairman of the Stratumseind hotel 

and catering association. For the pub owners especially the 3D microphone sensors are relevant to 

check their own noise level. The amount of visitors can be relevant for the overarching association for 

sponsoring opportunities. The 3D microphone data can be used to monitor whether their pub stays 

within noise limits. It is therefore of major importance that noise regulations are included in the 

visualisation. The pub owners highly value their privacy. When pub owners can have insight in the 

noise levels of their neighbours it might lead to an undesirable effect. They require additional research 

concerning privacy before all sensor data becomes open to everyone. In the end they need a simple 

visualisation without plenty of tables and figures where the sound level of the relevant pub can be 

interpreted immediately.   

 The third interview is held with a networker from the police of Eindhoven. This interviewee 

facilitates the connection between on the one hand the police and on the other hand parties such as 

the municipality, pub owners, porters, breweries et cetera. In a few years the police would like to be 

able to use sensor data to make Stratumseind a safer place. On the one hand this could be with the 

aid of sensor data. For instance they might de-escalate a situation by changing the light or smell in the 

area. On the other hand this could be according to sensor data if for instance a message is 

automatically sent to the police when a combination of data indicates a possible escalation. For this 

latter goal it is important to first examine the statistical relationships between police figures and a 

combination of sensor data. A very important requirement for the police is that sensor data should be 

retrievable real-time with the shortest interval possible. That is caused by the time pressure the police 

has when data indicates an escalation. Due to this time pressure, the visualisation needs to be as 

simple as possible. The police employees do have the age and educational level to process more 

advanced visualisations. However, the time needed to interpret a visualisation should be minimised to 

stimulate fast response. Furthermore the visualisations should be aimed for use at the central police 

office and not aimed at policemen walking around in the area. It would be handy to have it on location 

but it is not required for several reasons. First, the policemen should be able to focus completely on 

core tasks. It can be the case that they are busy with an observation or arrest. Secondly, a policeman 

at the central office can respond to the information without possible direct emotion of a policeman at 

location. The people at the central office can then forward the message, if it seems that something is 

going on, to the policemen at location. Furthermore it is very important for the police that time is 

shown as detailed as possible. A detailed time indication, including day and date, is needed if they 

have to retrieve videos from the public prosecutor for enforcement purposes. Finally, a visualisation of 

camera field of views can also be of interest for the police as new public order cameras are going to be 

installed in Stratumseind in the near future. The police could use a similar methodology to stimulate a 

useful camera coverage and to align these cameras with the people counting cameras of the living lab.

  The fourth interview was conducted with a property owner of several apartments and 

business premises in Stratumseind. For property owners there is no direct interest in the sensor data, 

however indirectly the sensor data could be useful. The overall interest of property owners is the 

quality improvement of the area. The property owners do therefore not require real-time sensor data. 

It is sufficient if peak moments can be retrieved afterwards. This sensor data could be used to check 

whether noise complaints of tenants are justified. Furthermore the noise data and the amount of 

visitors in the area can be used to determine the rent. For instance if more people are passing the area 

the property value rises. It is however of utmost importance that visualisations can be interpreted by 
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parties with a direct interest in the sensor data. If these parties can directly respond to certain 

situation it will in the end lead to an improved quality of the area and more interest in properties 

when they become empty.   

 

Table 1 summarises the above described requirements for the four most important requirements. A 

plus indicates a high demand for the particular requirement and a minus indicates a low demand. 

Especially the noise data and the real-time availability of data are important for most stakeholders.   

 

Table 1: stakeholder requirements 

Stakeholder Noise data Camera data Real-time data Textured city model 

Inhabitant + - + + 

Pub owner + +- + - 

Police +- - + +- 

Property owner +- +- - - 

 

The requirements of the target group can be used to define personas. These are fictional characters 

that represent the requirements of a real target group. Four different personas are thus created that 

are of importance for this research (figure 9-12). These personas summarise the most important 

characteristics and requirements of the target groups and connect these to a fictional person to make 

sure that people are kept in mind during the further process of this research.  

  The personas that were defined in this research based on the interview results, also called 

user profiles, are explained below. The profiles contain general information about the sex, age, and 

education level of the target group. The ‘where’ and ‘when’ furthermore provide information about 

when and where the user wants to retrieve information from the sensor data. Finally the goal and 

requirements show for what purpose they want to retrieve sensor information and what their 

requirements are.  

 

 

Figure 9: inhabitant user profile 
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Figure 10: pub owner user profile 

 

Figure 11: policeman user profile 
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Figure 12: property owner user profile 
 

5.1.2 A PERFECT MATCH? 
The match between sensor data supply and stakeholder demand can be roughly compared for three 

different aspects: the 3D model in general, the people counting cameras and the 3D microphones. 

With respect to the 3D model in general the requirements vary across the stakeholders. Some argue 

that the current LOD2 city model, which is not photo-realistic, is sufficient in combination with sensor 

data. By using a grey city model the focus can be shifted towards the actual sensor data visualisation. 

Especially the police and inhabitants state that there is a need for more detail. The current 3D city 

model should, according to the police, be coupled with names of bars or housing numbers for 

instance. Then it can still be monitored from which particular building the noise is coming. The 

inhabitants have a different view. They do have a strong demand for a photo-realistic 3D city model as 

they want to be able to recognise the buildings at a glance. If they notice noise nuisance then they do 

not want to spend time finding out from which specific building the noise is coming. They argue that 

pub names vary through time and that the livery and appearance of buildings remains the same. 

According to the inhabitants there is thus a need for a more detailed city model, especially by using 

photos to make it more realistic.   

  With respect to the cameras, and thus the people counted in the area, there is a clear gap 

between the availability of sensor data and the demand by stakeholders. The cameras are able to 

count the amount of visitors entering or leaving the area within each field of view. The stakeholders 

however argue that this information is not detailed enough for most of the purposes for which they 

want to use this information. For instance they would like to connect the data about the amount of 

visitors with the noise information. This provides context information as a large amount of people will 

eventually lead to more noise. These relationships cannot be made with the current available data. 

The data from the different cameras together do only say something about the total amount of 

visitors in the whole area of Stratumseind. No conclusions can be made about the amount of visitors 

in one specific pub or in one specific area. This data is still useful but for more general purposes such 

as sponsoring or the determination of housing prices. These purposes are however less relevant for 

the objectives of Stratumseind 2.0. Furthermore, not all stakeholders directly require a visualisation of 

sensor range. Only the police mentioned that it might be useful for them as they need new police 
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cameras in the area as well. A visualisation can help to determine the optimal locations for new police 

cameras. By preference they want these new police cameras to be aligned with the people counting 

cameras.   

 Data about noise produced has, compared to the counted visitors, a higher stakeholder 

demand. Especially for the inhabitants and pub owners it could be useful to monitor from which 

location or building noise originated. There are some problems with the current availability of this data 

that is collected by the 3D microphones. According to a meeting with Munisense and the data that has 

been examined, it is clear that the determination of noise sources is based on assumptions. This is very 

important as the current stakeholders were not fully aware of this. There are several downsides 

involved in the current method to make assumptions about noise sources. First is that the possibility 

of reverberant sound is not taken into account. Reverberant sound is quite obvious in a small street 

like Stratumseind with lots of buildings, and it might result in other angles than the angles that direct 

to the actual noise source. Second, the sensor has no rectification for the distance towards the noise 

producing source. In other words, if a pub is located closer to the sensor then it is more likely that 

sound from this pub will be collected at a higher dB level. Third, the sensor can measure only one 

observation at a time which is always the most dominant noise source. It can therefore be the case 

that the data about a noise source producing 1 dB lower than the dominant noise source, is not 

included in the database. Finally, currently a fixed source height of 150 centimetres is used which 

assumes that people are creating the sound. In a street like Stratumseind with lots of pubs, it is 

however also obvious that buildings are noise sources instead of people. These problems together 

might arouse a false impression of the actual noise sources. Furthermore, the current visualisation is 

two dimensional and still no conclusions can be made about the noise source if a line directs to 

buildings with more floors and owners. The current information availability of 3D microphones thus 

seems, at first sight, relatively in line with the stakeholder requirements however there is a need for 

further optimisation of the noise source determination method.   

 

5.1.3 VISIBILITY ANALYSES 
Some of the problems described in the previous section create opportunities for 3D GIS to help reduce 

or overcome these problems. The opportunities lay especially within the 3D city model in general and 

the 3D microphones noise source determination method. With respect to the 3D city model, 3D GIS 

can be used to make it more detailed and realistic. This is, as already explained in section 2.3, beyond 

the scope of this project. 3D GIS can however play a major role in the optimisation process of the 

noise source determination method. This is illustrated with figure 13. It is the same figure as in section 

4.4 but now it includes a building. Munisense does not have 3D information and therefore they use 

150 centimetres as a source height. The figure shows that 3D information can have a big impact on 

the determination of the noise source. Based on the current method, point A would be determined as 

the noise source. It is however much more logical that point B (or the building) is the actual noise 

source. If there were really people outside at point A creating sound, the sound would go beyond the 

building and it would reach the sensor at a completely different angle. But without 3D information, 

they (i.e. the people from Muinsense) just do not know that this building is located here. Still point B is 

an assumption of the noise source, but it is more obvious than point A. This section will show the 

effects of including 3D information in the noise source determination method. By using some of the 

data collected at Stratumseind it can be investigated whether the use of 3D GIS really makes a 

difference or if it unveils new patterns. 
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Figure 13: inclusion of 3D information in noise source determination method  

 

The line that is being drawn in figure 13 is similar to the concept of a line of sight. Although the line is 

not a literal line of sight in this context, the concept can be used to determine the noise origin. Most 

common GIS software, such as ArcGIS, have functions to perform line of sight and other visibility 

analyses. For this research, the visibility tools of ArcScene 10.2.2 will be used to see if these tools are 

able to examine new patterns.  

The underlying idea of a line of sight analysis is that a linear line is being drawn between an observer 

location and a target location. A dataset with 3D objects or a raster with height values can then be 

used to determine the actual visibility. In other words, the line will be cut on the intersection point 

from where the line will be no longer visible from the observer location. In the case of the 3D 

microphones, the observer location will be the location of the sensor and the target location will be 

the location of the currently determined noise source. By performing visibility analyses point B can be 

determined.  

Appendix IV shows an extensive roadmap of all the steps that need to be taken to perform all the 

visibility analyses and to determine the new noise sources. The steps that need to be taken to 

determine the new noise source are a succession of different tools. Therefore, a model is created with 

the inbuilt ModelBuilder to easily repeat these steps for another sensor or in the future (see figure 

14). With this model one is able to examine the difference between point A and B of the previous 

figure. Also an extended version of the model has been created that can be used to visualise the actual 

dB level.  



47 
 

 

Figure 14: Visibility analysis model 

The result of the above model can be seen in figures 15 and 16. Both figures are exactly the same 

however in the second figure the city model layer is disabled to show the difference of adding or not 

adding 3D information. The green lines show the part of the line that is ‘visible’ from the location of 

the sensor. This corresponds with the line between the sensor and point B in figure 13. The red lines 

show the part of the line that is not visible from the location of the sensor as the view is blocked by 

one or more buildings. The red line thus corresponds with the line between point B and point A in 

figure 13.   

  From over 1000 noise measurements from different sensors in Stratumseind at different 

points of time it appeared that the distance between point A and B is approximately 17,50 meters. 

However this distance can reach up to more than 80 metres. This shows that adding 3D geo-

information can have a major impact on the location of the noise source that is being determined. The 

figures below confirm this impact. The webscene (section 5.3) also provides an overview of these 

visibility lines.  
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Figure 15: result visibility analysis with city model enabled 

 

Figure 16: result visibility analysis with city model disabled 

With the extended version of the ModelBuilder model the measured dB level is added to the existing 

sight lines. The symbology of the sightlines can then be changed in order to show the dB level on the 

lines. The colouring of the lines based on the LAeq (dB) attribute can be done in several ways. When 

using graduated colours the differences between the lines become clearly visible. However, this might 

create a wrong impression as the differences in dB level (from the same point of time) are usually very 

small. Therefore it is chosen to colour the lines based on the Dutch ‘Handreiking Omgevingslawaai 

2011’ (Guide Environmental Noise). This guide distinguishes six different dB classes and also proposes 

RGB colours for these classes (Ministry of I&M, 2011). Video 1 shows an animation of the data from 

one of the sensors on a Friday night.  The animation starts at 20:30 and ends at 08:30 the next day. 

The interval time for the animation is one hour. There is a difference in the number of observations 
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for each hour as some images show more lines than other. This difference is a result of two reasons. 

The first is that observations with a vertical angle between 0 and 90 are categorised as air noise and 

these are not included in the visualisation. The second reason is that the database will only write an 

observation to the database if the new observation differs from the previous one. There are even two 

points of time early in the morning that show no observation at all. The video gives a nice impression 

of the differences in noise level over the night as Friday is a typical night for a lot of people to go out in 

Stratumseind. 

 

 

Video 1: 3D microphone data animation (https://www.youtube.com/watch?v=6MiE71yW33M) 

The above video has a relatively long time interval of one hour. The data of a Thursday night, which is 

the night to go out for most students, between 00:00 and 01:00 have been examined in more detail. 

This timeframe has been chosen as almost all of the observations have a dB level of more than 70 

which is the highest class. This data has been investigated with a time interval of 5 minutes. It is 

striking that clusters on specific buildings can now be identified. These clusters were not visible 

without the addition of 3D information. Especially the sensors located at the entrances of 

Stratumseind show these kind of patterns. By adding 3D geo-information to the noise source 

determination method, new patterns can thus become visible.  

 

 

Figure 17: clusters of noise observations 
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5.1.4 CONCLUSIONS 
The results and findings of the first part of the research provide an answer to three sub questions: 

 Who are the stakeholders of smart sensor data and what requirements do they have 

concerning sensor information and visualisation? 

 To what extent do these requirements match the current availability of information? 

 How can 3D GIS contribute to a better alignment of data supply and stakeholder demand? 

The stakeholders defined as relevant for the case of this research are the inhabitants of Stratumseind, 

the property owners, the pub owners and the police. Obviously the requirements of these 

stakeholders are diverse. The overall conclusion that is clear is that there is need for the information 

collected by the 3D microphones, more than the data collected by the people counting cameras. It is 

thus of major importance that noise sources are determined and visualised accurately. It is also very 

important for most stakeholders that the data is visualised real-time with a very short interval to 

identify peak observations. Furthermore all stakeholders require a simple visualisation of sensor data, 

in such a way that all people can see patterns and draw conclusions from the visualisation.   

  The first part of the research furthermore showed that the match between the availability of 

sensor data and information and the demand by the stakeholders is not yet perfect. Improvements 

can be made with respect to the information level of the current city model, the information collected 

by the people counting cameras and the reliability of the current noise source determination method 

for the 3D microphones. The opportunities for GIS lie particularly in the first and the last aspect. The 

visibility analyses showed that 3D GIS can improve the alignment of data supply and stakeholder 

demand by adding 3D information to the current noise source determination method. By doing so, the 

noise sources become more reliable and new patterns become visible. Thereby it is easier for the 

stakeholders to identify the noise origin and to derive relevant information from the visualisation. 

 

5.2 Part II: FoV visualisation 
This section describes the results and findings from the second part of the research. Paragraph 5.2.1 

describes the findings from the use of the software SketchUp in combination with the Axis camera 

plugin. Paragraph 5.2.2 describes the results of using the Geodan toolbox. Both sections will pay 

attention to the advantages and disadvantages of the tools. The final section provides the answer to 

the sub question that relates to this section.   

 

5.2.1 AXIS PLUGIN FOR SKETCHUP 
There are some initial disadvantages of using the software SketchUp. SketchUp is more focused on the 

creation of building plans instead of a 3D model of bigger parts of a city. Furthermore, segments 

created in SketchUp are not related to a spatial location. It is possible to connect it to a location via 

Google Earth, however this is by far not accurate enough for GIS purposes. SketchUp should thus be 

used in combination with GIS software to add field of views to the right locations in the city model. GIS 

software can also be used to convert parts of the city model to a format compatible with SketchUp.  

Again, appendix IV provides an extensive description of the steps that need to be taken to create the 

field of views and to add these to the existing city model. Figure 18 shows the way it looks when field 

of views are visualised in SketchUp. Although the field of view looks fine, this image reflects some of 
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the disadvantages of the software. It contains only one part of a building of the city model. Also the 

building objects in the city model of Eindhoven are built from the 0 NAP level while the actual ground 

level in Eindhoven is around 20 metres. The building therefore appears higher than it is in reality. By 

adding the ground level layer in GIS software this optical illusion disappears. However it is not possible 

to add this ground level in SketchUp whereby it looks like the camera field of view is hanging far above 

the ground. Figure 19 shows the same image but now it is exported to ArcScene and the ground level 

is added to the scene. It created a totally different image. Furthermore, when exporting the SketchUp 

model to ArcScene, it becomes one multipatch object together with the building. This is difficult when 

for instance the colour should be adjusted.  

 

Figure 18: FoV creation in SketchUp 

 

Figure 19: FoV exported from SketchUp to ArcScene 

The advantage of SketchUp is that the extension is very interactive and easy to use. One is able to 

easily adjust the camera settings and the angles. Another advantage is that the standard settings of all 

Axis camera models are already pre-defined. The plugin does even contain mounts for several objects 

such as walls, corners, poles et cetera. The disadvantages are however that the output, when 

converted to ArcGIS, is a multipatch feature that has less visualisation possibilities than for instance a 

shapefile. Furthermore, a major disadvantage is that objects in SketchUp are not directly related to a 

projection system and that it is not possible to load the entire city model and ground level in the 

software. Especially for the sensor cameras in Stratumseind for which the angles are not known, it is 
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hard to make a good estimate of the vertical angle without the surrounding buildings, the ground level 

shapefile and an aerial photograph. Although it is easy to create camera field of views, this 

disadvantage has the result that with SketchUp no overall image can be created about the camera 

field of views within its environment. The extension would therefore be more useful for the 

visualisation of indoor camera field of views.   

 

5.2.2 GEODAN TOOLBOX 
The tool is however not yet ready so some additional steps must be taken to get the desired results 

out of it. The steps to create the field of views with the aid of this toolbox are again described in 

appendix IV. The input for the Geodan toolbox are the X, Y and Z coordinates of the sensor and the 

focal length. Based on this information a field of view shapefile is created where all angles are set to 0. 

These angles should thus be adjusted manually. However, for the sensor cameras in Stratumseind it is 

not known what the exact angles are and what the focal length is at which the cameras are currently 

set. The focal length is therefore set to the standard minimum focal length for this type of camera of 

which is 3mm. The azimuth is determined with the aid of the software ScreenScales and the vertical 

angle is adjusted based on a combination of screenshots of the camera live views and an aerial 

photograph.  

The resulting image is shown in figure 20. The figure is a screenshot of the webscene created with 

CityEngine (section 5.3). It shows that most of the Stratumseind entrances are covered by the current 

cameras. However there are three routes that people can use to avoid the cameras. These ‘invisible’ 

entrances are shown with a white dashed line in figure 20. The actual field of views can however still 

deviate from reality as the visualisation is based on estimates.   

 

Figure 20: overview of the camera field of views and uncovered entrances in Stratumseind  

 

The workflow shows that the Geodan toolbox compensates for the negatives of the Axis plugin, 

however at the moment it is not ideal and still some adjustments have to be made to optimise this 

toolbox. Currently the tool is still in progress and functions to adjust the vertical angle and to directly 

examine the visible and invisible areas of the FoV can be added in the near future.   
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5.2.3 CONCLUSIONS 
The previous two sections provided an answer to the final sub question: “How can 3D GIS be used to 

visualise the spatial extent of sensors?”. Two tools were tested for visualising 3D field of views with the 

aid of 3D GIS: the Axis plugin for SketchUp in combination with GIS software and the Geodan toolbox. 

It appeared that while the Axis plugin is very interactive and easy to use, it is better applicable for 

indoor modelling of camera FoVs. The Geodan toolbox is more focused on GIS applications and it 

works fine, however it is not finished yet and therefore some steps are currently quite devious. As it is 

still under construction, disadvantages of the Geodan tool might be reduced in the near future which 

makes it a promising tool. To conclude, the possibilities to visualise camera field of views in a 3D city 

model do exist, however they are not yet optimal.   

 

5.3 Webscene 
Some of the results, i.e. the camera field of views and visibility lines of three sensors, of this research 

are visualised with CityEngine and exported as a webscene. The webscene is publicly available via 

ArcGIS Online with the name ‘Stratumseind’. The webscene can also be viewed using this link. The 

webscene first shows the camera field of views to provide an overview of the camera coverage in the 

area. It is also possible to enable a layer with the visibility lines for three 3D microphone sensors. Only 

three of five 3D microphones visibility lines are shown in this research as there was no data available 

for all five sensors at the same point of time. The visibility lines of three sensors are however enough 

to give an impression of the difference between the current noise source determination method and 

the new noise source determination method with the aid of a 3D city model. In the webscene the city 

model (study area) can be switched on and off to see the difference. Furthermore, the 3D model 

might suggest that the sensors are floating in the air but in reality most of them are attached to poles 

that are not included in the 3D city model.   

 

5.4 Discussion 
The results should be interpreted with some caution. This section contains several discussion points 

that need to be taken into account. 

The first discussion point is that only one person or representative or each target group is interviewed. 

Therefore, the personas for the different target groups are also based on one stakeholder for each 

persona. It is possible that the opinion of these specific persons differ from the opinion of the other 

people included in the target group they represent. The decision to interview only one person per 

target group is made based on time reasons. It is strived to select those people that, due to their 

function, position or experience, can best reflect the needs of the bigger group. However it might 

always be the case that the needs would have been different if more people were included in this 

research.    

Secondly, the determination of noise sources is not yet ideal and it will always remain rough 

estimates. Noise is a very complex phenomenon. In reality, noise does not go linear as might be 

suggested by the straight lines drawn in section 5.2. Stratumseind is a small street with lots of 

buildings which can for instance cause a lot of reverberation of the noise. However as a noise expert 

from DGMR said in a meeting, the modelling of noise will always be a simplification of reality and the 

method described in this research is one of this simplification methods to determine the noise source. 

http://www.arcgis.com/apps/CEWebViewer/viewer.html?3dWebScene=31e8aaff3ca44e098749fc8a438f17ce
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This should always be kept in mind and communicated when sharing the data and visualisations.

 Another aspect important here is that the sensors do not compensate for distance and 

dominance. For instance when two different pubs in the street produce the same dB level that is too 

high, the noise from the pub closer to the sensor will generally sound more dominant than that of the 

pub further away. Only the most dominant noise level observed by the sensor will be written to the 

database. The pub that is located closer to the sensor might then automatically receive more 

complaints based on the sensor data than the pub further away.   

  Furthermore the last important aspect related to this discussion point is that currently all 

observations with a vertical angle between 0 and 90 are defined as sound coming from the air. This 

decision was made by Munisense as their current method to determine the noise source would lead 

to the drawing of an infinite line that never reaches the source height of 150 centimetres. The new 

noise source determination method, as provided by this research, is however able to determine the 

noise sources of some observations currently classified as air sound. This is because of the fact that 

surrounding buildings are sometimes higher than the height of the sensor. A vertical angle between 0 

and 90 may then lead to the upper floor of a building. These observations are not included in the 

research and therefore a location on the building higher than the sensor will never contain a noise 

source while in reality this might be different.   

  These difficulties show that it is still hard to determine the accurate position of a noise source. 

It should in any case be clear that the noise sources are based on assumptions and that they might 

differ from the actual noise sources. Otherwise wrong conclusions might be drawn from the data.  

A final discussion point is that the camera field of views are visualised based on assumptions. No 

information regarding angles and current settings of the cameras were available. Without this 

information it is hard to realistically reconstruct the field of views in a model. The visualisation 

overview of the camera field of view thus provides a general insight into the situation however it 

might deviate from the real situation. 
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6 CONCLUSIONS 
 

This research aimed to answer the following question: “What are the opportunities for 3D GIS to 

increase the information level of smart sensor data and to stimulate a better alignment between 

sensor data supply and stakeholder demand in a smart city?”. The answer to this question is based on 

a case study in Stratumseind, a bar district in Eindhoven, with the aid of the following sub questions: 

 What has been done already, both by academics and practitioners, concerning 3D+time 

visualisation of geographical sensor data? 

 Who are the stakeholders of smart sensor data and what requirements do they have 

concerning sensor information and visualisation? 

 To what extent do these requirements match the current availability of information? 

 How can 3D GIS contribute to a better alignment of data supply and stakeholder demand? 

 How can 3D GIS be used to visualise the spatial extent of sensors? 

The answers to these sub questions are explained in the conclusions of sections 3.10, 5.1.4 and 5.2.3. 

The overall conclusion of this research is that 3D GIS can create added value for stakeholders with 

opportunities focusing on three different aspects: the determination of a noise source, the use of 

textures on a city model and the 3D visualisation of sensor range. This chapter provides a more 

extensive explanation on this conclusion.  

 

6.1 Conclusions 
The research identified four stakeholders: the police, pub owners, property owners and inhabitants. 

Interviews with these stakeholders showed that although the requirements are diverse, there is a 

relatively high demand for an accurate visualisation of noise levels with its associated sources. From a 

comparison with the data availability it appeared that currently the two dimensional visualisation of 

noise sources is not accurate enough. The stakeholders require a visualisation of noise sources with a 

high accuracy. This is one of the aspects that creates a major opportunity for 3D GIS. Part of the 

reason why the current noise source determination is not satisfied is because of the lack of 3D 

information. This research showed that adding 3D information to the noise source determination 

method highly influences the location of the noise source. The distance between the original noise 

source and the newly created noise source with the aid of 3D GIS is approximately 17,50 metres. 3D 

visualisation can also unveil new patterns and clusters of noise sources on specific buildings. This 

enables people to reach a higher level in the DIKW pyramid.   

  Furthermore, inhabitants highly demand a photo-realistic 3D city model to identify and 

recognise buildings in the area. This is another major opportunity for 3D GIS although this opportunity 

is not further explored during this research. 

The final opportunity for 3D GIS explored in this research is to visualise the spatial extent of sensors, 

specifically camera field of views, in a 3D city model. This opportunity is not necessarily a result from 

the demand by the target group in this research, but more so a requirement of the municipality itself. 

The tools used to construct the field of views can both still be improved, but it possible to visualise 

these field of views in a city model with the aid of 3D GIS. The resulting image provides a clear 
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overview of the situation regarding the camera coverage. At a glance it also shows the areas that are 

not covered by the current cameras. Such a visualisation is furthermore not only useful to describe the 

current situation, the method is also useful to determine the optimal location for new cameras. 3D 

information is crucial as they determine the areas, blocked by objects, to be removed from a field of 

view. 

Although the field of smart cities and sensors in combination with 3D GIS is hardly explored, this 

research already showed that there are some big opportunities for 3D GIS. As we are on the eve of a 

3D geo-information revolution, there are probably even more opportunities related to this context 

that will be discovered in the near future.  

 

6.2 Recommendations 
Smart cities and the implementation of sensors are a recent development that gained much 

importance among both academics and practitioners over the past few years. However the 

combination of these concepts with 3D GIS on which this research was focusing is a field that has 

many possibilities for future research. There are thus plenty of possibilities for future research. This 

section will therefore propose some recommendations.  

During this research it became clear that the requirements concerning the city model vary among the 

different stakeholders. On the one hand, the inhabitants require a realistic 3D city model to better 

recognise the specific buildings. There is no direct need to increase the level of detail of the city model 

however it needs to be enriched with for instance photos to make it look more familiar. This can be 

done manually but this will be a very time consuming process, especially for the entire city. There are 

currently some developments going on to automate the process of attaching photos to 3D objects. 

These developments might be interesting for the improvement of city models. However in the case of 

Eindhoven there are a lot of geometry errors in the city model that need to be repaired before photos 

can be attached to the objects and before 3D GIS can use it as 3D data.  

  On the other hand there are purposes for which textures are less relevant. For instance for 

governmental tasks it is more relevant to have an up-to-date and accurate city model. Textures are 

especially of added value for visualisation but for most analyses it is sufficient to have an up-to-date 

and accurate LOD1 or LOD2 object-based city model. It is therefore recommended not to focus on one 

specific type of city model. The level of detail highly depends on the purposes for which the city model 

is to be used.  

Secondly, it would be better if the 3D visualisation of sensor data becomes real-time. Most 

stakeholders require a short interval real-time visualisation to directly identify the situation or 

exceptional peak observations. The current 2D real-time visualisation of the 3D microphones does not 

provide enough accuracy to give a realistic overview of the noise sources.    

  It is furthermore recommended to make this real-time visualisation interactive. There is a 

particular need to manipulate the aspect of time. Stakeholders want to be able to retrieve sensor 

information from the past. A simple slider or a query option is thus needed to visualise the sensor data 

from earlier points of time.  

Thirdly, ownership of vertical properties is an important aspect that should become clear in the city 

model. Stratumseind is an area where lots of buildings have more than one owner. For instance the 

ground floor belongs to a pub whether students are living on the first floor. The current city model 
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does not make any reference to ownership or tenants. Therefore it is currently not clear who is 

responsible for the noise if a noise source is being visualised on a building.  

 

In this research the sensors were examined independently of each other. For future research it is 

recommended to combine the sensor data of all sensors in the area and to use statistical analyses to 

recognise patterns and relationships. The aim of the living lab is to increase liveability and to reduce 

crime and conflict. Relationships found from past sensor data can help to predict future situations. The 

relationships can be incorporated in a visualisation to ‘warn’ people for a certain situation. This is of 

major importance for the realisation of the project goals.  

Finally, legislation can be of added value for a sensor data visualisation. For instance showing a dB 

level might not provide enough information as it is just a number. The dB level will be more interesting 

if it is related to the allowed dB level. This is also interesting from a GIS point of view. The legislation 

differs for each building and with the aid of geo-fences automatic notifications can be send when 

legislation is exceeded.   
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Conferences 
This list provides the dates and names of all the conferences, conventions and symposia that are 

visited on behalf of this research. 

 19-06-2014 | 3D BGT day. Amersfoort, Netherlands 

 25-09-2014 | Making Sense for Society, Living Lab for the IoE. Eindhoven, Netherlands. 

 29-10-2014 | National breakthrough 3D. Delft, Netherlands. 

 30-10-2014 | Hexagon Geospatial Benelux user conference. Capelle a/d Ijssel, Netherlands.  
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APPENDIX II: INTERVIEW 
 

(short introduction to the research and the interview) 

Introduction 

-  What is your role/function? 

-  How are you involved in the living lab 2.0 project?  

 

Characteristics represented target group (e.g. inhabitants, pub owners, police et cetera) 

-  What is the average age of your target group? 

-  What is the average education level of your target group?  

-  Where, i.e. on what kind of location, do you need the information?  

- Is there a time pressure when you want to retrieve information?  

-  Is the sensor data of both sensors included in this research, people counting cameras and 3D 

  microphones, relevant for your target group?  

-  For which purposes do you want to use the sensor data? 

Open questions 

- How should a visualisation of sensor data look like?  

-  What should a good visualisation include at least?  

- Do you also want to interact with the sensor data? Do you want to perform for instance 

  analyses over the sensor data?  

 

General visualisation requirements 

- Do you think that 3D visualisations add value with respect to 2D visualisations? Why? 

- On what kind of moments do you want to retrieve the sensor information?  

- Do you want to retrieve sensor data real-time or post-processed? Why? 

-  Do you want buildings to be visualised realistic (e.g. with the aid of photos) or simple to focus 

  more on the sensor data?  

-  Do you want all sensor data visualised together in one overarching environment or do you 

  want a separate visualisation environment for each sensor? Why? 

 

Specific visualisation requirements 

- Do you think that an object-based visualisation (e.g. visualisation of dB on buildings) would be 

  of added value? If yes, would you prefer an object-based or a surface-based visualisation? 

  (explanation of the terms object-based and surface-based) 

- Would you prefer to see only the actual measurements of the 3D microphones or would you 

  want the visualisation to include extra information, for instance information that represents 

  the decrease in noise over a certain distance. Why? 

- Do you want to retrieve sensor data at any moment or do you want to retrieve it after a 

  certain limit is exceeded (e.g. amount of visitors, dB limit)? Why? 

- Should legal issues, e.g. noise regulations/limits, always be included in a visualisation? In other 

  words, should regulations also be included when measured values do not exceed limits? 
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Visualisation of time 

- How specific should time be designated? Is it sufficient to state a point of time? Or is it 

  important to include the day and date as well? Why?   

-  How should time be visualised? Is it for instance enough to state it somewhere in a corner or 

  should it perhaps be designated in another way? If yes, how?  

- How detailed should real-time information be? In other words, what is the required time 

  interval of real-time information?  

- When information is retrieved afterwards, do you want to retrieve information of one specific 

  point of time or do you want to retrieve information of a broader time frame? 

 

Final question  

-  Are there any other things that are important for you with respect to a good and useful 3D 

  visualisation of sensor data? 

(thanking for cooperation and finalising the conversation) 
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APPENDIX III: PROCESSED INTERVIEWS (DUTCH) 
 

Interview 1: Serge Hoes 
24-10-2014, Inhabitant Stratumseind and chairman inhabitant platform 

 

(Introductie interview en onderzoek)  

 

Wat is uw rol/functie en hoe bent u betrokken bij Stratumseind?  

Ik ben voorzitter van het bewonersplatform. Er zijn een aantal verenigingen van eigenaren op 

Stratumseind. Die zijn allemaal als VVE vertegenwoordigd. Er zijn ook een aantal een losse bewoners 

en huurgedeeltes en dat komt allemaal bij mij terecht gezamenlijk. Wij hebben 1 keer in de zoveel tijd 

een vergadering om dingen te bespreken. Dat is niet meteen met alle doelgroepen bij elkaar, want dat 

noemen we de kwaliteitskring met o.a. de politie en gemeente. Maar wij hebben ook separaat nog 

besprekingen met alleen bewoners. Want het is niet altijd handig om iedereen je kaarten te laten zien.  

Wat is ongeveer de gemiddelde leeftijd onder de bewoners?  

Dat zal rond de 45 zijn.  

En wat is het gemiddelde opleidingsniveau?  

Dat is grotendeels HBO als ik kijk naar de grootste vertenwoordiging. Er zijn veel appartementen die 

kosten niet onder de 3 of 4 ton en daar zitten toch wel zeker 200 bewoners. Bij de Catherine kerk 

wonen veel studenten, zij zijn nog in opleiding maar dat zijn ook veelal TU mensen. Bij de zijkant van 

Stratumseind bij de oude stadsgracht daar is sociale huur en daar is heel veel differentiatie, van 

gepensioneerden tot net uitgezette mensen. Daar durf ik niets over te zeggen. Dan zijn er ook nog een 

aantal studenten die boven de kroegen wonen.  

Zit er voor jullie een tijdsdruk achter het opvragen van informatie?  

Dat hangt er vanaf welke sensor het is. Stel dat wij last hebben van geluid dan zou ik het in real-time 

willen kunnen zien. Zodat je kunt aanwijzen van het is die kroeg, of dat je er naartoe kunt lopen om te 

zeggen van hey doe je deur eens dicht. Perceptie speelt ook een grote rol vanwege de weerkaatsingen 

van de muren. Dus wanneer het kroeg A is, en het gaat een paar keer heen en weer dan kan het lijken 

alsof het kroeg C is.  

Is het voor jullie ook van belang om de bezoekersaantallen real-time te kunnen raadplegen?  

Nee in wezen niet. Ja het is wel handig bij evenementen om te kijken of je makkelijk thuis kunt komen, 

of je bij de parkeergarage kunt. Dat wel. Maar voor grote evenementen niet echt.  

Dus als ik het goed begrijp zijn voor jullie beide sensoren van belang, maar zijn de gegevens van de 3D 

geluidssensoren het belangrijkst. Klopt dat?  

Dat klopt ja.  

Waarvoor zouden jullie verder de sensordata willen gebruiken?  

We gebruiken het niet alleen om te kijken wanneer het geluid te hard is. Daar moet je namelijk niet 

altijd vanuit gaan. Het kan heel goed zijn dat het geluid binnen de norm is, maar dat iemand zich er 

juist aan stoort omdat het niet zijn muziek is. Je moet dat ook kunnen weerleggen met die data. Ik krijg 

heel veel klachten van mensen, maar dan is het soms nog wel binnen de regels. Dat is vaak 

gevoelsmatig, het kan bijvoorbeeld net zijn dat iemand griep heeft of hoofdpijn. Als je kunt 
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onderbouwen met gegevens dan kun je tegen die mensen zeggen dat ze niet moeten zeuren omdat ze 

kroegen zich netjes aan de norm houden. Als je dat koppelt met de hoeveelheid mensen dan kun je 

ook zeggen van nou het leek wel alsof de kroegen veel lawaai maakten, maar er liepen ook 2000 

mensen door de straat en die maken ook lawaai. Daar tegenover staat dat als er op zondagavond 1 

kroeg lawaai maakt en er lopen maar 10 mensen op straat dan kun je dat ook tegen die kroeg zeggen 

van goh wat is het nut? 

Heeft u al een beeld van hoe de visualisatie er uiteindelijk uit moeten komen te zien?  

Ik ben bekend van de beelden van MuniSense. Wij werken al een jaar of 5 met een decibel systeem in 

de stad, wat ik als voorzitter mag uitlezen. Dat is echter statisch, 2D. Ik zie alleen maar op en bepaalde 

lantaarnpaal van zoveel decibel komt er binnen. Er bleek toen dat dat voor evenementen goed werkte 

omdat je dan weet of er overlast wordt veroorzaakt. De 3D sensoren die zijn er vooral voor de cohesie 

in de straat. Zodat we inderdaad zeggen van joh jouw bedrijfsleider was vergeten zijn deuren dicht te 

doen vannacht. In plaats van dat wij tegen de hele straat zeggen van joh jullie zaten te kloten. Want 

daarmee neemt de aversie naar elkaar toe. Het is ook voor de ondernemers zelf prettig om te kunnen 

zeggen van nee ik was het niet dat was mijn buurman, kijk maar naar de gegevens. Wij zullen het 

graag zo simpel mogelijk willen zien. Want je zult het voor iedereen inzichtelijk moeten houden. Dan is 

het niet echt van belang voor die mensen wat de exacte waarde is, maar groen geel of rood is zat. Die 

perceptie hebben ze wel. Wel exact op locatie zoveel mogelijk. De real-time komt dan in gevaar want 

als die echt real-time is knippert die veel te veel. Er zal dus een vertraging op moet worden gezet. Dat 

als er bijvoorbeeld een melding doorgaat, dat die 10 seconde blijft hangen.  

Wat moet het interval zijn waarmee real-time informatie moet worden weergegeven?  

Een minuut zou kunnen maar 10 minuten al zeker niet meer. Dit komt omdat overlast veelal binnen 10 

minuten plaatsvindt. 10 seconde is misschien wat kort door de bocht maar ik denk ook niet dat het 

meer dan een halve minuut moet zijn. Want op het moment dat ik naar buiten kijkt en je kijkt naar de 

internetaansluiting dan wil je 1 op 1 kunnen zien. En als je een halve minuut later weer andere muziek 

hoort dan wil je kunnen zeggen oke nou is het van de buurman of nu komt het van een andere kant af. 

Als je het te lang laat hangen dan heb je niets aan die gegevens, dan kun je de pieken er niet meer 

uithalen.  

Zouden jullie ook interactie willen met de visualisatieomgeving?  

Voor een paar mensen, zoals ik of een aantal andere voorzitters van eigenaren zouden 

analysemogelijkheden heel goed zijn. Ook omdat wij daarmee onze achterban van informatie kunnen 

voorzien. Maar wij zijn ook veel meer opgeleid in het systeem. Mensen die het systeem niet kennen 

moeten het gewoon aan kunnen zetten en kunnen zien van hier, daar staat het. Zij hebben niets aan 

bijvoorbeeld de afgelopen week. Zij kijken alleen maar voor de overlast op dat moment. En als wij dan 

te horen krijgen een paar keer in de week die kroeg of die kroeg. Dan hebben wij iets aan 

analysegegevens om te kunnen kijken of het inderdaad 5x in de week die bepaalde kroeg is. Dan 

kunnen we Eugene, de straatmanager zeggen dat hij iets moet regelen en er iets mee moet doen.  

Voor bewoners is het dus niet van belang om informatie achteraf te kunnen opvragen?  

Nou, misschien voor 3 dagen terug. Van bijvoorbeeld het weekend. Maar dan wel weer in de waardes 

waarin ze voor hun begrijpelijk zijn.  

Zien jullie de meerwaarde van een 3D visualisatie ten opzichte van 2D?  

Ja, omdat de gevoelswaarde van de metingen veel groter is. Plus dat je, klinkt even heel cru, kunt 
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zeggen één van de bewoners had een feestje op zondagavond. Het was dan niet de kroeg beneden 

hem, maar de tuindeur stond open. Je hebt ook een aantal horecazaken die hebben een verdieping. 

Dan is het beneden helemaal gesloten en als je door de straat loopt dan zie je niets maar als het van 

de eerste verdieping komt dan is het weer iets anders. Er zijn ook horecazaken die zitten alleen maar 

op de eerste verdieping gescheiden van de begane grond, dan heb je dus alweer een hoogte nodig.  

Zouden gebouwen realistisch moeten worden aangekleed met foto’s of moeten ze zo simpel mogelijk 

worden weergegeven?  

Ik denk dat het voor de kijker hoe duidelijker hoe beter is. Dat heeft ook te maken met de 

gedachtegang van die mensen, zovan het is die kroeg. Sommige die kunnen gewoon in de badjas naar 

buiten stappen van joh doe die deur eens dicht. Dan moeten ze niet gaan lopen zoeken welke kroeg 

het was. Het is dan niet voldoende om data van de kroegennamen te koppelen aan een simpel 

weergegeven gebouw. Er is namelijk heel veel wisseling van kroegnamen in Stratumseind. Het uiterlijk 

van de panden is vrijwel altijd hetzelfde en de kleurstelling is ook vrijwel altijd hetzelfde. Dat er dan af 

en toe een ander naamsbordje op staat dat maakt niet zoveel uit. Namen vinden we dus niet zo van 

belang. Als je een klacht hebt moet je toch aangeven welk adres het is. Ik ken ze allemaal uit mijn 

hoofd maar niet bij iedereen is dat zo. En het is ook wel handig als je niet meteen alle namen erbij 

hebt staan zodat niet iemand op Twitter gaat zetten van vanavond is Jantje alweer aan het kloten, 

want dan krijg je meteen negatieve PR.  

Zouden jullie één overzicht willen met alle sensoren of een apart overzicht per sensor?  

Een combinatie is denk ik het beste. Voor de gespecialiseerden om het zo maar even te zeggen, zoals 

ik, zou een differentiatie beter zijn. Wij zitten meer in de know how van het gegeven en zeker met het 

verleden als je daar naar kijkt dat je dingen naast elkaar kan leggen. Want als we iedere keer een 

koelwagen hebben die bij cafetaria De Hoek voor de deur staat en die overlast geeft. Dan ben je gauw 

geneigd om te zeggen dat cafetaria De Hoek overlast maakt. Maar dat is een friettent. Dus dan weet je 

al in je achterhoofd, dat klopt niet. Maar op het moment dat ik die sensordata heb en die 

videobeelden en zie dat het iedere keer die vrachtwagen is dan kun je het anders aanpakken.  

Zouden jullie geluid of bezoekersaantallen altijd inzichtelijk willen hebben of alleen als er een grens 

wordt overschreden?  

Altijd, omdat je dan ook het perceptiegevoel kunt onderbouwen. Want dan zie je bijvoorbeeld alleen 

maar groen en dan heb je niets te zeggen ook al kun je er nog steeds last van hebben. Het is 

toegestaan om hier in de stad lawaai te maken met een fanfare, daar is geen vergunning voor nodig. 

Maar op het moment dat je er elektriciteit op aansluit dan heb je er vergunning voor nodig, dan is het 

andere wetgeving. Alsnog kun je heel veel last hebben van die fanfare, maar daar kun je niets over 

zeggen want die mag dat. De kleur zal dan altijd groen blijven maar de perceptie van de mensen zal 

wel zijn van ‘ja daar hebben we ze weer’. Of de megafoons van de studentenintro, heel irritant. Maar 

zij maken geen muziek en dan mag het weer. Maar die vallen wel op de meter op. Die zie je voorbij 

komen en dan kun je dus zien van oke dat was dus een verplaatsbare megafoon. Dan snap je veel 

eerder waar jouw grens ligt.  

Zou dat soort regelgeving in de uiteindelijke omgeving moeten worden meegenomen?  

Dat is altijd handig. Er is een meting gedaan door de gemeente waarin is bepaald wat de maximale 

waardes zijn die een kroeg mag maken. Die max waardes die zouden een mooie aanleiding kunnen zijn 

als basis. Het zou bijvoorbeeld kunnen zijn dat ze pieken en dat ze dan naar geel gaan, maar als je 5 

minuten piekt dat je dan naar rood gaat. Als je dan weet van nou ze mogen maximaal 80 en ze gaan 
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eroverheen, maar er is een andere kroeg en die mag 90 en die kan eroverheen gaan. Dan is voor jou 

van belang wat is zijn uiterlijke waarde? Mag hij dat gewoon? Of gaan ze ineens allemaal 92 en valt het 

dan niet op omdat zijn buurman dan zo hard is. 

Zou het van meerwaarde zijn om geluid te visualiseren op gebouwen?  

Dan zou bijvoorbeeld de koelwagen of de veegwagen wegvallen, en dat is ook een bron van ergernis. 

Het lijkt me dus meer gewenst om het geluid in de ruimte te visualiseren. Het geluid hoeft niet 

gebouw eigen te zijn. Het lawaai kan ook een koeling boven op een dak zijn. Dan kun je je de pleuris 

zoeken op zondagochtend waar het lawaai vandaan komt. Alles is dicht maar ergens hoor je een 

irritant geluid.  

Is het van meerwaarde om extra informatie, zoals de afname van geluid in afstand, te betrekken in de 

visualisatie van geluid?  

Dat weet ik niet. Daar heb ik geen ervaring mee. Ik denk het eerlijk gezegd niet. Waarom omdat 

degene die een klacht heeft nooit zal accepteren dat die in de groene cirkel zit vanwege een 

berekening. Hij luistert namelijk naar zijn eigen oren en zijn eigen perceptie daarin. Zoiets is wel 

interessant bij een langdurige geluidsoverdracht. Dus stel als je een evenement hebt waar je 10 uur 

lang 90 decibel hebt dat je dan aangeeft hoe het geluid in de regio buiten het gebied is. Dan weten 

mensen bijvoorbeeld van nou ik moet naar dat park gaan want dan heb ik er geen last van. Het nadeel 

is wel van zo’n visualisatie dat heel snel heel je 3D model helemaal vol is. En ik denk dat dat teveel 

informatie wordt voor de leek. Voor ons bijvoorbeeld zou het wel heel handig zijn. Je zou het 

bijvoorbeeld kunnen gebruiken bij een waarschuwing. Als er bijvoorbeeld wordt gezegd nou volgende 

week is er een studentenintro, dit zijn de gegevens van vorig jaar dus zorg dat je uit dat gebied bent. 

  

En hoe specifiek moet tijd worden weergegeven?  

Tijd moet zo specifiek mogelijk worden weergegeven: dus tijd, dag en datum. Als mensen denken van 

nou wat hoor ik nou, was dat niet gisteren ook al? Dan moet ik niet allemaal moeilijke Excel sheets 

moeten intikken of weet ik het. Dan moet ik gewoon 1 dag terug met een tijdbalk klaar. Oh wacht, 

gisteren was het ook al en de dag daarvoor ook al. Dan maak je het een stuk makkelijker. 

Is het dan voldoende om tijd in bijv. in een bovenhoek weer te geven of moet dit op een andere manier 

zichtbaar worden?  

Het zou beter zijn als bijv. gegevens in een chronologische volgorde wordt weergegeven in een 

tijdbalk. Dan kunnen mensen gewoon scrollen en dan zien ze in een balk beneden de tijd wel voorbij 

komen.  

Is het voldoende om gegevens achteraf van één tijdstip te kunnen opvragen of is het van belang dat 

mensen gegevens van meerdere achtereenvolgende tijdstippen kunnen opvragen in bijv. een soort 

animatie? 

Dat laatste is zeker handig. Want bijvoorbeeld iemand die ’s morgens wakker wordt en ’s nachts een 

paar keer wakker is geworden van geluid dan zou die ’s ochtends willen kijken wat er aan de hand was. 

Wanneer diegene het hele blok kan verzamelen dan kan die zien dat het bijvoorbeeld meerdere 

kroegen waren, of heel ander geluid bijvoorbeeld bezoekers waren. Als hij die informatie in 1x in een 

overzicht ziet in een blok dan zul je heel anders met die interpretatie omgaan. Dan zal hij ook eerder 

zeggen van luister ik heb er last van gehad.  
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Zijn er verder nog dingen waar ik rekening mee moet houden voor een uiteindelijk visualisatie? 

Zo speels mogelijk noem ik het altijd. Dus dat iemand, zoals gepensioneerden die niet dagelijks met de 

computer werken, die zouden ook met enige uitleg ermee overweg moeten kunnen. Doordat wij de 

informatie heel makkelijk interpreteren omdat wij er veel verder in zijn kunnen wij veel sneller de 

juiste informatie vinden. Voor iedereen moet het begrijpelijk zijn.  

 

Interview 2: René Willaert 
24-10-2014, Pub owner Stratumseind 

 

(Introductie interview en onderzoek)  

 

Wat is uw functie?  

Ik ben momenteel niet meer de voorzitter van de horecavereniging, dat is nu Tom die zit hier 

tegenover. We doen het eigenlijk een beetje samen, laat ik het zo zeggen.  

Hoe zijn jullie betrokken bij het living lab Stratumseind project?  

We zijn betrokken als zijnde vereniging, dus alle horecabedrijven hier in de straat. Wij zijn daar de 

woordvoerders van. Het gaat met name om ons, er zijn ook meerdere bedrijven. We hebben er 

bijvoorbeeld ook wel eens bewoners. Normaal gesproken vergaderen we 1 keer in de maand. We 

zitten vlak bij elkaar dus het is eigenlijk heel kort. En we hebben er een overkoepelend straatmanager 

bij die alles monitort en in de gaten houdt. Hij zegt dan bijvoorbeeld nou jongens we moeten volgende 

week even bij elkaar komen. Meestal gaat dat wel per onderwerp.  

Wat is ongeveer de gemiddelde leeftijd van de horecaondernemers?  

Ik ben de oudste. Ik verwacht zo rond de 30-35. Ze zijn vrij jong.  

Wat is het gemiddelde opleidingsniveau?  

Ruim MBO, af en toe een HBOtje ertussen. 

Waar is het voor jullie belangrijk dat jullie die informatie kunnen raadplegen?  

De meesten doen dat thuis.  

Zit er voor jullie een tijdsdruk achter het opvragen van informatie?  

Nee we zijn er nog helemaal niet mee bezig. Het zit nog allemaal in de kinderschoenen. In principe zijn 

die gegevens nog helemaal niet vrijgegeven. Wij hebben daar nog geen inzicht in. Iedereen heeft het 

living lab wel een keer gezien maar de volgende stap moet nog gezet worden. Ik denk dat onderzoek 

ook bepalend is wat er wel en niet openbaar gaat worden en welke gegevens wel of niet gebruikt gaan 

worden. Een gedeelte van de gegevens zal wel naar de gemeente gaan, naar de handhaver. En een 

ander deel van de gegevens gaat waarschijnlijk naar ons van dit doen jullie en daar willen we naartoe. 

Dat 3D is nog niet wettelijk onderbouwd.   

Zijn zowel de 3D geluidssensoren als de telcamera’s voor jullie van toepassing?  

Dat geluid is gewoon een gegeven. Waarschijnlijk willen ze dadelijk zeggen van gisteravond heb jij zo 

laat en zo laat de muziek te hard gehad. Het is dus een continue controle wat je dadelijk krijgt, big 

brother is watching you. Niet iedereen is daar even blij mee. Maar het kan wel zijn dat je daardoor 

straks minder problemen gaat krijgen, minder overtredingen. Het is even wennen. Maar hoe gaan ze 
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die gegevens gebruiken? Als ze dadelijk gaan zeggen van je bent 2 decibel te hard geweest dus jij moet 

volgende week dicht omdat jij dit gedaan hebt en dit gedaan hebt zo zwart-wit moet het niet gaan 

worden. De bezoekersaantallen zijn overkoepelend gezien wel belangrijk als vereniging zijnde. Dat kan 

van belang zijn als we sponsoren nodig hebben voor een evenement of noem maar op. Dan kunnen 

wij gewoon zeggen van nou er komen zoveel mensen en dat is ook gemeten, het is geen 

nattevingerwerk. Het Stratumseind an sich kunnen we dan makkelijker verkopen. Verder zijn wij er 

nog niet echt mee bezig. Bijna alles is meetbaar, en wij weten dat het gemeten wordt. Maar wat er 

allemaal mee gedaan gaat worden daar zullen we zelf ook nog iets mee moeten verzinnen. 

Heeft u al een beeld over hoe u zelf graag wilt dat een uiteindelijk visualisatie eruit komt te zien? 

Het moet gewoon makkelijk te lezen. Als ik bij Tinus op het living lab zit dan zie ik wel een hele hoop 

tabellen en lijntjes en weet ik allemaal maar in principe moet ik gewoon kunnen zeggen van nou op 

mijn punt stond die en die datum zo en zo laat de muziek zo hard. Oh verrek, ik ben daar over de 

scheef gegaan of daar over de scheef gegaan. Het aantal mensen is opzich niet zo heel belangrijk 

omdat iedereen zijn eigen bedrijfje heeft. Dat er 100 mensen binnenkomen wil niet zeggen dat er 100 

mensen naar mij toe gaan of naar mijn buurman. Dan heb je ook nog eens doorloop publiek. Daar zijn 

dingen daar kan je wel iets mee doen maar daar kun je alleen als groep iets mee doen, zelf niet 

volgens mij. 

Zou u ook interactie willen met de uiteindelijk visualisatie?  

Geen idee, dat is nu allemaal nog te pril.  

Denkt u dat 3D visualisatie wel een meerwaarde heeft ten opzichte van 2D?  

Het camerawerk zou je in 2D kunnen doen. Maar voor het geluid moet je wel in 3D doen om een punt 

te kunnen bepalen.  

Willen jullie de informatie real-time kunnen raadplegen of is achteraf ook voldoende?  

Voor mij is achteraf ook goed. Het zou wel leuk zijn. Maar hebben we daar iets aan? Misschien wel. Op 

het moment dat ik een live band neerzet dan kan ik zeggen van jongens jullie moeten wat zachter 

want ik zie hier nou dat het niet klopt. Dus daar zijn wel mogelijkheden voor. Dat zou eerst uitgezocht 

moeten worden. Eigenlijk zijn de mogelijkheden onbeperkt maar dat wil niet zeggen dat het allemaal 

makkelijker, leuker en beter gaat worden.  

Zouden gebouwen realistisch moeten worden weergegeven of juist zo simpel mogelijk?  

Niet direct. Maar ik denk dat dit niet te uitgebreid moet zijn. Ik denk dat je het beter grijs kunt houden. 

Anders wordt het en te veel plus dat er andere dingen gaan gebeuren. In hoeverre ga je die gegevens 

dadelijk inkijken? Kan ik dan bijvoorbeeld zien hoe hard mijn buurman draait? Dat zijn ook allemaal 

dingen waarmee je moet opletten. Ik weet niet of het privacygevoelig is. Beelden dat is wettelijk 

onderbouwd maar geluid is niet wettelijk onderbouwd, dus hoe ver is dat privacy? 

Willen jullie uiteindelijk graag 1 omgeving met alle sensordata of een aparte visualisatie per sensor? 

Ik zou dat gewoon allemaal bij elkaar houden. 

Zou u de gegevens altijd inzichtelijk willen hebben of alleen wanneer er een grens wordt overschreden? 

Altijd. Je geluid daar ga je vaak overheen. Maar die dingen gebeuren ook met 3 of 4 bezoekers binnen. 

Vaak op het begin van de avond dan zetten ze de deuren open en de muziek hard en dan denken ze 

dan komen die mensen wel. Maar dat werkt averechts. Maar iedere nieuweling die doet dat weer. Dat 

zijn weer dingen waarvan je kunt zeggen: je hebt dat en dat gedaan. Waarom? Er zijn 3 mensen bij jou 
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binnen. En dat dat een keer gebeurd dat snap ik wel maar als dat te vaak gebeurd dan kun je er 

iemand op aanspreken.  

Heeft het visualiseren van geluid op de gebouwobjecten een meerwaarde?  

Ik denk dat het geluid overal gevisualiseerd moet worden. Dan heb je vergelijkingsmateriaal. Het is wel 

zo, en dan zit je weer op het stukje privacy, moet mijn buurman weten hoe hard mijn muziek staat? Ik 

zou die gegevens bij wijze van spreken online kunnen bekijken. Maar als ik op een zaterdagavond thuis 

zit om 12 uur dan kan ik zeggen van nou daar achteraan zijn ze helemaal gek.  

Zou het dan beter zijn wanneer je alleen voor je eigen kroeg kunt bekijken hoeveel geluid er wordt 

gemeten? 

Misschien wel. Dat is een juridisch vraagstuk, in hoeverre mag je die gegevens inzien. Het is een stukje 

privacy. Maar in hoeverre is dat privacy? Zoals nu als ze geluidsmetingen doen in de straat en er komt 

zo’n rapport uit dat ligt dan bij de gemeente. De eigenaar weet dat en de gemeente weet dat maar ik 

weet niet wat de meetwaardes zijn van andere cafés of andere zaken. Dat moet je ook niet willen 

weten. Dat heeft ook weer te maken met de waarde van jouw pand. In dat opzicht is het ook weer 

privacygevoelig. Als ik morgen mijn café wil verkopen dan kan iedereen al zien van nou dat moet je 

niet kopen.  

Is het van meerwaarde om extra informatie toe tevoegen, bijvoorbeeld informatie over hoe snel het 

geluid afneemt in de ruimte?  

Opzich zou dat wel werken. Dat heeft zeker wel een meerwaarde. Hoe scherper je dat doet, dan zie je 

ook waar je lekkage zit in een gebouw.  

Zou regelgeving m.b.t geluid of bezoekersaantallen ook moeten worden opgenomen in de visualisatie? 

Ja, die hoort erbij. Want waarom zou je anders meten? 

Hoe specifiek moet tijd worden weergegeven?  

De tijd is het belangrijkst. Op het moment dat ik hier zelf niet aanwezig ben en er staat 4 man 

personeel te werken, ’s middags 2 en ’s avonds 2 dan wil ik wel weten of dat het ’s middags of ’s 

avonds is gebeurd. Of dat het ’s avonds is gebeurd in een piek van een omzet, of toen dat bandje net 

begon. Als je een tijdstip hebt kun je erop handelen. Ook de dag en de datum is van belang, tijd moet 

zo exact mogelijk worden weergegeven.  

Is het voldoende als dit bijv. in een hoek wordt weergegeven?  

Ja dat is prima, zolang het maar vindbaar is. 

Wanneer gegevens real-time informatie worden weergegeven, wat is dan het interval waarmee de 

visualisatie moet worden aangepast?  

Het liefst zo vlug mogelijk, 10 seconden hoeft niet. Maar 5 a 10 minuten is wel nodig. Het zijn vaak 

pieken. Het is een bandje of er komt een club publiek binnen die een bepaald nummer willen horen. 

Dan moet je dus kunnen zien van toen en toen ging het te hard. Jij stond te draaien en ik kan precies 

terugkijken welk nummer ik toen gedraaid heb. Is daar een reden voor geweest of is daar geen reden 

voor geweest? Dat kan voor mij ook verdedigend werken naar de handhaver toe. Als hij dan zegt dat 

wij te hard stonden dan kan ik bijvoorbeeld zien ja dat klopt maar de rest van de straat ook want PSV 

scoorde bijvoorbeeld 2 keer achter elkaar.  
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Als je informatie achteraf raadpleegt, is het dan voldoende om dat van 1 tijdstip te kunnen doen of zou 

je een animatie van meerdere tijdstippen willen zien?  

Dat laatste, want je moet de pieken eruit kunnen pakken. Het gaat ons met name om die pieken. 

Zijn er verder nog dingen die ik moet meenemen in mijn onderzoek die voor jullie belangrijk zijn? 

Nee in de eerste instatie niet. Er zal dadelijk in een keer iets komen. Daar kunnen we dan nog op 

schieten. Van eigenlijk zou dit kunnen en later zou dat kunnen. Dat is nu nog lastig omdat we er nog 

helemaal geen inzicht in hebben. Het is nog vrij nieuwe materie allemaal. Elke keer komt er iets 

nieuws bij. Het werkt wel. Alleen nu moeten die gegevens ergens in geimplementeerd worden.  

 

Interview 3: Andries de Vries 
31-10-2014, Networker police Eindhoven 

 

(Introductie interview en onderzoek) 

Wat is uw rol/functie?  

Dat is een functie dat heette vroeger netwerker binnen de politie. Je moet je voorstellen bij de oude 

organisatie, we zitten nu in een transitieperiode, kende deze regio die functie. De hoe en de wat vraag 

hebben ze van elkaar losgekoppeld. En ik bemoeide me met de wat vraag. En de uitvoering dat ligt bij 

anderen. Dat heet bij ons rationele chefs. Ik ben op een gegeven moment twee jaar terug gevraagd of 

ik de verbinding wilde zijn in het kader van horeca, tussen horeca, gemeente, politie, polyground, 

portiers, brouwerijen. Dus alles wat met de horeca te maken heeft en dat is enorm breed. Daar hou ik 

me grotendeels mee bezig. 

Op wat voor manier bent u betrokken bij het living lab?  

Nu op dit moment niet altijd heel erg druk, maar het komt wel in het werk terug. En zeker straks in de 

toekomst als dingen concreet gaan worden. Wij hebben ook camera’s voor openbare orde die 

geplaatst zijn. Die naderen hun einde levensduur. Dus volgend jaar komt er een update van dat hele 

plan. Dus wij zijn daar nu al heel erg mee bezig. Welke camera’s hebben we? Wat willen we nog meer? 

Wat is een ideaal situatie? Hoe kunnen we daar straks gebruik van maken? Wat is onze kennis en wat 

zijn onze gemissen? Het zou zo mooi zijn als we dat straks kunnen koppelen met de dingen van living 

lab. De bedoeling is ooit in mijn stoutste dromen dat wij een signaaltje krijgen van ga naar coordinaat 

4 want daar dreigt nu een escalatie. Maar dan is het wel verrekte handig als we daar zelf op datzelfde 

moment ook de camera’s van RTR daarop gericht hebben. Dat je gebruik van die verschillende dingen 

gaat doen. Wij kunnen niet de camera’s van Tinus gebruiken, dat heeft een ander doel en dat moet 

ook gescheiden blijven denk ik. Maar het doel is wel het beinvloeden met licht, geluid en geur of wat 

dan ook.  

Wat is het verschil tussen de politie en RTR?  

RTR is een particuliere organisatie die door alle gemeenten wordt ingehuurd. Het zit wel in een 

politiebureau en de verbondenheid is enorm groot.  ’s Nachts als het horecateam werkt dan zit er ook 

een operator van ons daarbij, zodat als er iets is hij wel specifiek en strafrechtgericht daarop kunnen 

inzoomen en de beelden anders kunnen bedienen dan bijvoorbeeld een burger die daar zit. Die heeft 

wel veel kennis van het systeem, die snapt echt wel van de bewegingen dat er iets aan de hand is 

maar je moet wel straatervaring hebben om het nog beter te kunnen interpreteren. Ik ben zeer 
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geinteresseerd in alle kansen die we kunnen hebben om gewoon de doelstelling van Stratumseind, 

schoon, heel en veilig, te kunnen halen. Dat doen we voor het publiek maar ook voor mijn collega’s. 

Als mijn collega’s daar veilig rondlopen dan is het voor mensen die daar komen stappen ook veilig. 

Gisteren zo’n treffende opmerking van een horecaondernemer, dat is een beetje de filosofie waarin 

hij leeft, hij zei dat hij in zijn eigen zaak veilig rond wil kunnen lopen en ik moet tegen iemand aan 

kunnen botsen die dan alleen maar zegt: “sorry”. Zo moet dat eigenlijk hier ook kunnen worden. Daar 

kunnen we de techniek dan voor gebruiken.  

Waar zouden jullie de 3D geluidssensoren of de telcamera’s voor willen gebruiken bij de politie? 

Eigenlijk voor hetzelfde als wat ik net zei. Als we eenmaal zo ver zijn dat we aan de geluiden een 

conclusie kunnen verbinden, dat we daar dan ook een actie op gaan plegen. En misschien is het wel 

10x zinloos maar de 11e keer is het wel een goede indicator van iets. Daar hoop ik dan op. De eerste 

stap is dan om te kijken naar verbanden tussen bijv. geluid en ongeregeldheden. Daar kunnen we dan 

eventueel wijzigingen van het straatbeeld op afstemmen. We zien ook dat bepaalde kroegen een 

verandering van publiek krijgen omdat er bijvoorbeeld een andere eigenaar met weer een andere 

muziekstijl in zit. Dus ook de cameraopstelling (die van ons) zou flexibeler moeten kunnen. Dat kun je 

wel gebruiken van de sensoren. Waar we nu afhankelijk van zijn is gewoon het visuele. Dus wat de 

collega’s zelf zien. Die hebben daar intussen wel een neusje voor. Wij hebben 5 of 6 vaste collega’s 

van waar wij de horecateams uit plannen. En we hebben 6 vaste horeca projectleiders en één van die 

zessen is altijd in dienst. Daar hebben zij een neusje voor en dat is één. Twee is dat RTR aan de hand 

van bewegingen ziet van: hey, daar is iets aan de hand. Dat wordt dan direct per portofoon 

doorgegeven. We hebben ook de horecatelefoon, dat is een 06 nummer die alleen operationeel is als 

het horecateam werkt. Alle ondernemers en portiers hebben dat nummer ook. Dus als er wat is dan 

bellen zij de horecatelefoon. De collega die daar zit die houdt alles in de gaten en die roept dat via een 

portofoon gelijk door. Een vierde is de mensen die via 112 de politie bellen, of een melding aan 

collega’s geven. Dan moet dit zeker een uitbreiding kunnen zijn. 

Is het dan ook belangrijk dat het bereik van jullie eigen camera’s wordt gevisualiseerd?  

Ja het zou wel heel handig zijn als er een soort van synchronisatie in zou zitten. Ik ga er vanuit dat de 

mensen die hierbij betrokken zijn ook bij de plaatsing van de openbare orde camera’s zijn. Wij gaan 

dat nu helemaal opzetten. Ik heb zelf ook een paar techneuten rondlopen hier die echt weten waar ze 

het over hebben. Die draaien ook af en toe als operator mee in de RTR ruimte maar zij lopen ook op 

straat. Zij weten het van alle kanten, plus dat zij echt technische ervaring hebben. Dus zij hebben al 

een plan gemaakt waar camera’s moeten komen te hangen. Dat heeft iemand van RTR ook gedaan die 

alleen maar achter zijn monitor heeft gezeten maar van daaruit wel ervaring heeft. Hij weet 

bijvoorbeeld dat als er bij een bepaalde kroeg iets gebeurd en je zoomt dan in dat het zo grofkorrelig 

wordt dat je het eigenlijk niet kunt gebruiken. Ik wil zien dat iemand dat doet. Als je heel erg inzoomt 

dan zie je het niet. En als je heel erg uitzoomt dan is het beeld wel zuiver maar dan zie je de details 

weer niet. Die dingen leg ik over elkaar heen. Het zou wel fijn zijn als dat synchroon zou lopen met het 

living lab. Technisch is het al mogelijk om slimme camerasystemen te gebruiken met 

gezichtsherkenning. Hoe zit dat? Straks geven we heel veel geld uit om camera’s die daar al voor 

gebruikt zouden kunnen worden op te hangen. Straks mag het ineens en dan moeten we de camera’s 

weer gaan verhangen, dat is ook niet slim. Dus daar moeten we echt al toekomst gericht naar kijken 

bij het nu al installeren. Dat hebben wij ook al besproken. Stel dat die camera’s die wij hebben daar 

ook voor gebruikt zouden mogen worden dan is het wel verrekte handig om te weten of het in de 

huidige en toekomstige technieken valt en in de huidige fysieke plaatsing.  
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Waar zouden jullie de informatie willen raadplegen? Op het kantoor of juist op locatie?  

Het zou handig zijn om het op locatie te doen maar ik denk niet dat dat goed is. Ik denk dat het op de 

centrale post raadpleegbaar moet kunnen zijn. De collega’s op straat moet je niet belasten met dat 

soort dingen. Dat zul je merken als je uitgaat, ga maar eens 10 minuten naar ze kijken. Ze staan met 

iedereen te praten maar intussen staan ze heel onbeleefd te scannen. 

Zou het voor die mensen dan beter zijn om informatie op locatie wordt weergegeven alleen wanneer 

een bepaalde grens wordt overschreden?  

Ik vind dat je dat weg moet halen bij degenen die op straat aan het surveilleren zijn. Een centraal 

figuur kan daar zonder directe emotie op reageren. Misschien zijn ze wel bezig, degenen die het 

signaal als eerste hadden moeten ontvangen. Bijvoorbeeld observeren, of keuren of aanhouden. Dat is 

even vanuit praktisch politieoptreden. 

Wat is de gemiddelde leeftijd van de politiemensen die de informatie moeten kunnen interpreteren? 

Nou dat zijn allemaal jonge gasten. Er lopen een paar ouderen tussen maar ze zijn bijna allemaal 

twintigers of begin dertig. Er zijn een paar ouderen die er een beetje blijven hangen. Je zult eigenlijk 

geen mensen net als ik in die leeftijd rond zien lopen. Je moet dat leuk vinden want het is heel lastig 

en vermoeiend werk. Het is fysiek zwaar en je moet er ook getraind voor zijn. Maar je moet er ook 

tegen kunnen want je wordt constant lastig gevallen. Je doet het nooit goed, ook die souplesse is wel 

handig als ze dat hebben. Ze moeten dus niet te jong zijn maar we proberen toch wel onervaren 

collega’s ook mee te nemen omdat ze toch ook dat wel moeten ervaren. Maar het zijn jonge mensen. 

Wat is het gemiddelde opleidingsniveau?  

Meestal is dat HBO.  

Zouden jullie informatie real-time of achteraf willen raadplegen?  

Ik denk dat je dat proefondervindelijk moet vaststellen wat handig daarin is. Het moet niet zo zijn dat 

je constant achter meldingen vanuit het systeem gaat rennen. Het is ook handig om achteraf te 

kunnen kijken van ja, er is iets gebeurd. Maar dat zal in een scanperiode moeten gaan denk ik. Er is 

iets gebeurd waar we eerder op hadden kunnen acteren of misschien later. Het is lastig want het is 

een nieuwe techniek die je laat aansturen door expert programma’s.  

Zouden jullie interactie willen met de data?  

Nee informatie moet eigenlijk zo simpel mogelijk worden weergegeven. Wij zijn in onze uitvoering van 

werkzaamheden in ondergeschiktheid van het bevoegd gezag. We lopen in het kader van de openbare 

orde. Dat is in principe de eerste regel. De openbare orde dat ligt bij de burgemeester. Wij moeten 

uitkijken dat we niet dingen naar ons toe trekken die niet van ons zijn terwijl het wel harstikke handig 

is voor het uitvoeren van onze werkzaamheden. Een deel van de werkzaamheden zullen ook steeds 

meer terecht gaan komen bij de opsporingsambtenaren van de gemeente, zij die de handhaving doen. 

Want de geluidsindicatoren of sensoren melden iets en daar doen wij niets mee. Dat is puur voor de 

gemeente, voor handhaving. Maar die verbanden moeten wel gelegd worden dus er zal wel iemand 

moeten buigen, of korte lijnen naar ons toe, of dat je iemand zeg maar ontkleurt en tussen de twee 

organisaties inzet. Dat kan. En zeker in zo’n proefperiode kost het zeker investering van beide partijen. 

Ik ben er altijd zeer geinteresseerd in maar het moet niet zo zijn dat wij hier een bureautje analysten 

gaan krijgen. Dat denk ik niet dat dat goed is. Maar er moet wel een terugkoppeling komen met onze 

criminogene analysten en met de anderen. Ik denk dat we daar wel een zuivere scheiding in maken 

terwijl het wel overlapt.  
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Hebben jullie al een beeld hoe een visualisatie eruit moet komen te zien?  

Nee in die zin hebben we er nog niet over nageacht. Ik ben er al wel regelmatig geweest en toen heb 

ik wel dingen gezien. Ik stel me zo voor een monitor met vloeiende beelden aan de hand van al die 

indicatoren die belangrijk zijn voor het handhaven van de openbare orde. Nee niet het handhaven, 

maar aan de voorkant komen van de problemen. Daar is het eigenlijk voor bedoeld. Een telsysteem is 

makkelijk, dat kun je volgende week ook doen. Dat zou het makkelijkste zijn. Het toezichtsgebied waar 

je dan bezig bent, dat kun je op festivalterreinen bijvoorbeeld ook doen, dat je het verdeelt in 

sectoren zoals het logischerwijs eigenlijk altijd al gebeurd, en dat je daar dan iets visueels van maakt. 

Het moet in ieder geval makkelijk, simpel zijn. Daar bedoel ik niet mee dat politiemensen simpel zijn, 

maar wij moeten altijd direct handelen. Het moet dus ‘pats’ direct zichtbaar zijn en voor de rest komt 

het wel.  

In hoeverre zit er een tijdsdruk achter het opvragen van informatie voor jullie?  

Er is zeker een tijdsdruk, zo werkt de politie. Als er iets gebeurt op Stratumseind, ze zien hele kluwen 

mensen, hup zij duiken daar bovenop. Zij trekken de figuren eruit die ze aanhouden en daarna gaan 

we pas onderzoeken. Uitzoeken hoe het precies zit komt later. Er moet in ieder geval meteen duidelijk 

worden dat er een bepaalde situatie was.  

Zien jullie een meerwaarde van 3D visualisaties ten opzichte van 2D visualisaties?  

Daar heb ik nog geen beeld van. Ik denk zelf dat voorlopig 2D al heel veel is, een view van bovenaf. Bij 

3D kan ik me nog niet zoveel voorstellen, niet voor ons werk op dit moment.  

Is het beter om gebouwen realistisch of juist simpel weer te geven?  

Je moet uitkijken dat je niet teveel afgeleid wordt door allerlei andere situaties. Een naam ofzoiets of 

een nummer zou wel fijn zijn. In ieder geval moeten we niet teveel worden afgeleid van hetgene waar 

het in feite om gaat. We willen zo snel mogelijk de zaak rustig zien te krijgen tot de escalatie voorbij en 

we moeten niet teveel afgeleid worden.  

Is het van meerwaarde om extra informatie toe te voegen aan de visualisatie, bijv. informatie over de 

afname van geluid in de ruimte?  

Dat denk ik wel. Dan kom je echt tot de plaats waar je moet zijn als je het aangeeft in kleuren. Rood is 

het kernpunt waar je moet zijn. Het is ook handig want afgelopen nacht bijvoorbeeld was er een kroeg 

nog na sluitingstijd open. Om kwart over 2 was het nog open. En de muziek draaide nog. Dan wil ik 

juist terugkijkend weten van hey, gaf dat op dat moment nog overlast. En wat was specifiek het 

verschil ten opzichte van de omgeving. Dan kun je met gerichte informatie naar de ondernemer terug 

en eventueel een bestuurlijke rapportage naar de gemeente. Voor ons is het in ieder geval belangrijk 

dat het wordt gekoppeld aan politiecijfers. 

Is het van meerwaarde om het geluid te visualiseren op de gebouwen in plaats van in de ruimte? 

Wij treden op bij heftige geluidsoverlast. En verder is het eigenlijk de handhaving van de gemeente 

dus daar moeten wij ook niet al teveel in gaan zitten roeren. We werken wel samen hoor. Ik heb 

gisteren nog contact gehad over de meetgegevens waar ze aan mogen voldoen. Dat is voor ons ook 

van belang om te weten. 

Moet deze regelgeving dan ook in de visualisatie worden weergegeven?  

Nee, de mensen op straat hoeven dit niet te weten. Wij wel. Wij proberen er zo snel mogelijk bovenop 

te zitten, we kunnen concrete informatie geven. Als de collega’s muteren of rapporteren dat er 



79 
 

ongeveer 30 man binnen was. Dat is goed voor mij. Het mooiste is zelfs nog om te zeggen 28 man en 

94 decibel. Dan kun je ook iets doen met die concrete informatie.  

De telcamera’s tellen alleen het totaal aantal bezoekers, hebben jullie nog wel iets aan die informatie? 

Nee wij zouden misschien ooit, als het allemaal echt draait, dat we dat wel uitroepbaar zouden 

kunnen hebben maar collega’s moeten ook niet teveel afgeleid worden. Zij moeten echt het werk 

doen. Het is allemaal harstikke interessant als je dat kunt zien maar het zal ons eigenlijk boeien als we 

de verschillen kunnen zien. Als we bijvoorbeeld weten dat er in kroeg A altijd 100 man zit en ineens zit 

er 1000 man, is dat een indicator dat er iets aan de hand is? Nee, dat kan. Er kunnen ook 1000 

bejaarden zijn maar daar heb je echt geen last van. Dus we hebben niet altijd iets aan aantallen. En 

wat er binnen zit dat zegt soms iets over het weer, en minder over openbare orde of problemen. Als 

het bijvoorbeeld mooi weer is met Koninginnedag dan staat iedereen buiten en dan staat er niemand 

binnen. In de zin van crowdmanagement hebben we er wel wat aan, en de collega’s die in de horeca 

lopen. Als er op sommige mensen zich heel veel mensen concentreren en er is geluid of er is een 

overschrijding van een bepaalde grens want dan kunnen zij even gaan kijken of er iets aan de hand is. 

Als er niets is dan gaat het van ons over, ook al zou dat op een vlekkenkaart pimpelpaars worden.  

Hoe specifiek moet tijd worden weergegeven?  

Op het moment zelf, dus real time, is een tijdstip voldoende. Maar als het voor opsporingsdoeleinden 

wordt gebruikt, stel dat er iemand is neergestoken of wat dan ook, dan is het altijd heel erg belangrijk 

dat wij beelden kunnen opvragen via de officier van justitie. Die kunnen we dan voor 

strafrechtsituaties gebruiken. Dan is het dus wel belangrijk dat we daarvan een exacte tijdsaanduiding 

hebben. Maar stel dat we de beelden real time gebruiken dan weet je al wat voor dag en datum het is. 

Het is voor ons voldoende om het gewoon in een hoek van een scherm wordt weergegeven. 

Hoe gedetailleerd moet real-time informatie zijn?  

Het liefst zo gedetailleerd mogelijk, dat vreet natuurlijk capaciteit dat begrijp ik. Maargoed daar moet 

ik me niet druk om maken. Wij zien natuurlijk in politiewerk dat het ineens omslaat en het ook ineens 

weer voorbij is. Een massale vechtpartij duurt een paar seconden.  

Wanneer gegevens achteraf worden geraadpleegd, moet dat dan van 1 tijdstip zijn of van een tijdsblok? 

Een tijdsblok, we zoeken altijd daarnaar. Iedereen heeft toch zoiets van oke bij mij is het nu zo laat 

maar ik weet niet hoe laat het bij jou is en dat komt soms heel nauw.  

Zijn er verder nog dingen die voor jullie belangrijk zijn voor een goede visualisatie?  

Wat belangrijk is is dat we overal bij worden betrokken en dat worden we al, en dat is heel fijn. En dan 

kijken we zelf of het belangrijk is. En die samenwerking, we weten elkaar heel makkelijk te vinden. Ook 

vanuit de gemeente, ik zit er niet dagelijks maar wel bijna dagelijks. Het gaat heel makkelijk. En de 

straatmanager en de ondernemers dat is allemaal zo makkelijk voor ons. We boeken daar gewoon 

winst in met elkaar. Het was een gemis toen niemand van ons zich meer heel specifiek met de horeca 

bezig hield. Sinds ik terug ben is dat zo makkelijk geworden weer voor iedereen om elkaar op te 

zoeken. En je kunt verbeteringen gewoon creëren daardoor. Soms maak je dingen duidelijk die niet 

altijd prettig zijn voor mensen, ook voor onszelf intern. Want ik ga gewoon mijn vinger op zere plekken 

leggen, want dat doe ik ook bij de horeca of ook bij de gemeente. Dat is belangrijk en technisch als er 

ontwikkelingen zijn dan denk ik dat wij er automatisch ook bij betrokken worden altijd. De lijntjes zijn 

heel erg kort. Dus Stratumseind of een evenement ik zou het heel leuk vinden als deze hele gedachte 

en techniek zodanig wordt dat je het ook mobiel zou kunnen gebruiken, bijvoorbeeld bij 
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evenemententerreinen. Bijvoorbeeld op een kermisterrein of op het stadshuisplein of tijdens een 

dance event. Er zijn nog veel dingen die we met elkaar moeten onderzoeken natuurlijk maar ik ben 

wel heel benieuwd hoe het straks gaat in combinatie met het systeem. Worden wij dan bijvoorbeeld 

geroepen met het systeem? En hoe dat gaat met de verlichting. Of wij daar een rol in krijgen met een 

schuifje en of wij de verlichting zelf kunnen gaan beinvloeden. Wie gaat dat doen en hoe gaat dat 

gebeuren? Het systeem kan namelijk ook tegen ons gebruikt worden. Vanuit de gedachte als er iets 

gebeurt dan moeten de collega’s er naartoe lopen. Echt lopen. Anders komt het publiek achter hem 

aan. Het publiek heeft ook heel snel door dat als het licht van een lantaarnpaal hoger gaat dat daar 

iets aan de hand is. Dus ook daar moeten wij rekening mee leren houden. Dat moeten we ook gaan 

testen. Dat kun je makkelijk testen. Ook daar moeten we zeker bij betrokken blijven.  

Interview 4: Roy Daemen 
07-11-2014, Property owner Stratumseind 

 

(Introductie interview en onderzoek) 

Op welke manier bent u betrokken bij het living lab?  

Ik ben pandeigenaar aan de kop van het Stratumseind. Daar hebben wij een stuk of 6 panden: 6 

bedrijfspanden en een stuk of 16 appartementen. En van daaruit heeft Eugene van Gerwen van 

Polyground mij gevraagd om deel te nemen in Stratumseind 2.0. En onderdeel van Stratumseind 2.0 is 

het living lab. Dus op die manier ben ik erbij betrokken. Het is ook van mijn belang dat die straat naar 

een ander niveau wordt getild. We komen gemiddeld 5, 6 keer per jaar bij elkaar. We hebben nu een 

kwaliteitsplan laten maken waarbij we zeggen van nou, we willen die kant op. Dat is bijna gereed en 

dan willen we dat voorleggen aan de gemeente om te kijken met de gemeente samen of we dat 

kunnen realiseren. En de straatmanager die is daarnaast ook nog bezig met de ondernemers en de 

brouwerijen. Dus daar worden meerdere groepen bij betrokken. Om zo met z’n allen te kijken of we 

langzaam maar zeker een bepaalde richting op kunnen gaan.  

Waarvoor zouden jullie als pandeigenaren de sensordata willen gebruiken?  

Ja uiteindelijk, als pandeigenaar zodra het pand is verhuurd is ons belang voor een heel groot deel 

weg. In ieder geval het directe belang. Dan hebben wij enkel en alleen nog het indirecte belang. Op de 

lange termijn als die huurder weggaat dan moet de omgeving van die aard zijn dat het makkelijk is om 

het te verhuren. We hebben dus niet echt direct belang bij bijvoorbeeld de geluidssensoren. Ik denk 

wel dat we die gegevens kunnen gebruiken bij het opsturen van de kwaliteit. Dan denk je eigenlijk aan 

de meest simpele toepassingen om de geluidsoverlast naar de omgeving toe te beperken. Of die data 

gebruiken om te onderzoeken wat er leeft en speelt bij de bezoekers en hoe je dat kunt verbeteren. 

Hoe groter de kwaliteit van de straat, want dat is uiteindelijk mijn belang, hoe groter de courantheid 

van het pand om het te verhuren.  

Op wat voor soort momenten zouden jullie dan de data willen raadplegen?  

Ik denk dat voor pandeigenaren dat die data zelf niet relevant zijn maar dat het voor ons wel van 

belang is dat er partijen zijn die er iets mee doen, bijvoorbeeld living lab of Tinus Kanters. Dat zij die 

informatie kunnen analyseren en daar informatie uit kunnen genereren die alle exploitanten of 

huurders of gebruikers van die straat daar iets mee kunnen doen. Wij zijn zelf een groot voorstander 

van wonen boven winkels. Waar wij tegenaan lopen op een straat als Stratumseind is dat de bewoners 

boven geen last willen hebben bij de muziek. Enerzijds hebben wij een belang dat de mensen muziek 
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kunnen draaien want dan heb je voldoende bezoekers, maar anderszijds moeten onze bewoners ook 

niet teveel overlast hebben. Daar zou je de data opzich wel voor kunnen gebruiken. Als bijvoorbeeld 

dezelfde kroeg heel vaak overlast voor onze bewoners veroorzaakt dat we dan kunnen aanwijzen waar 

dat vandaan komt. Zovan: op basis van deze gegevens weten we dat jij daarvoor verantwoordelijk 

bent. We willen dus dat jij het aanpast. Het is voor ons dus niet van belang dat de data real-time wordt 

weergegeven. 

Wat is de gemiddelde leeftijd van pandeigenaren in Stratumseind?  

 Je hebt twee categorieën eigenaren, dat zijn brouwers en beleggers. Brouwers daar zit geen leeftijd 

aan en die zullen ook een terugtrekkende beweging maken. De beleggers dat weet ik niet maar ik gok 

rond de 50/55.  

En wat is het gemiddelde opleidingsniveau?  

Ik denk MBO+ maar dat weet ik niet zeker.  

Hebben jullie onderling als pandeigenaren geen platform voor Stratumseind?  

Nee, niet of nog niet. Als ik kijk in het algemeen dan was er tot voor een paar jaar terug totaal geen 

noodzaak voor een samenwerking. En ik merk nu op Stratumseind, maar ook op andere plekken, de 

behoefte tot samenwerking dat dat veel meer van belang wordt omdat de leegstand toeneemt. We 

hebben daar 2 of 3 jaar geleden een initiatief toe genomen. Toen hebben we heel duidelijk met 

Stratumseind 2.0 gezegd van nou we gaan eerst een visie bepalen en om een invulling te geven aan 

die visie gaan wij die mensen benaderen. We hebben ze 1 of 2x bij elkaar gehad tot nu toe en daarbij 

is onze strategie geweest om ons te richten op mensen die actie willen ondernemen. Je hebt altijd 

mensen die maakt het niet uit of die geven er niets om, die minder bereidwillig zijn. Die hebben we 

voorlopig even links laten liggen maar die willen we in een later stadium wel enthousiasmeren. Ik denk 

dat je een aantal mensen hebt die vroeger kroegeigenaar zijn geweest en die hebben het pand 

gekocht en vervolgens de kroeg verkocht. Zij zien dat dus als een vorm van beleggen. Ja dan heb je 

een aantal ondernemers die naast ondernemen ook nog vastgoed beleggen. Die hebben af en toe een 

pand gekocht en je hebt ook de serieuze of de echte beleggers. Die zien dat als hun vak. Je hebt dus 

drie soorten eigenaren, ja en de brouwers. Het is wel zo dat 4 of 5, in ieder geval een beperkt aantal 

eigenaren, een heel groot percentage panden waarbij ik de brouwers even meetel. Er zijn 58 panden 

en wij hebben er 6. Iemand anders heeft er 3. Er zijn ook een drietal brouwers die er meer dan 5 of 6 

hebben.  

Is voor jullie de data van de telcamera’s van belang?  

Nee. Ja en nee. Direct, zolang het verhuurd is niet. Dan is het met name voor de exploitant of huurder 

van belang. Indirect natuurlijk wel, want hoe meer mensen, hoe aantrekkelijker het voor de verhuur is. 

Je ziet met name in de winkelgebieden, ik ben even de naam van het systeem kwijt, maar dan kun je 

opvragen hoeveel passanten er zijn per stuk van de straat. Binnen vastgoedland hebben wij zo’n 

systeem waarbij we precies kunnen zien op welke straat hoeveel mensen er gemiddelde komen. Voor 

het vaststellen van de huurprijs is dat voor ons wel van belang. Als ik dat aantoon dat dat er minimaal 

10.000 mensen per dag langskomen dan kan ik een andere huurprijs realiseren dat wanneer er maar 1 

iemand per dag langsloopt. Dus daar zou het voor ons van belang kunnen zijn. Tot op heden is dat 

gebeurd met fysieke tellingen. De camera’s is dan iets actueler. Maar heel direct niet. Maar dan kom ik 

weer terug op het standpunt dat het voor ons eigenlijk pas van belang is als het niet meer verhuurd is 

of als huurcontracten moeten worden verlengd. Hoe meer passanten, hoe sterker ik sta.  
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Heeft u al een beeld hoe een visualisatieomgeving er voor jullie uit moet zien?  

Dat hoeft niet gedetailleerd te zijn. Ik kan het me voorstellen dat het voor sommige procedures als er 

een procedure begint dat dan voor de exploitant en voor de huurder en wellicht ook voor de 

pandeigenaar van belang dat gegevens tot in detail op te vragen zijn. Hoe verder een juridische 

procedure gaat hoe meer detailgegevens je nodig hebt. Maar in de eerste instantie moet het gewoon 

simpel zijn. 

Zien jullie de meerwaarde van 3D visualisaties ten opzichte van 2D?  

Voor pandeigenaren zie ik dat niet 1, 2, 3. Voor het zoeken van technische oplossingen van 

geluidsproblemen daar zou het van toegevoegde waarde kunnen zijn. Want daar zijn wij wel in 

geinteresseerd. Het is heel moeilijk te bepalen, we hebben appartementen boven in de nok, en waar 

komt het geluid dan precies vandaan. Hoe stroomt het geluid en waar zit het lek. 

Zouden jullie willen dat de gebouwen realistisch worden weergegeven of juist zo simpel mogelijk? 

Ik zou ze simpel weergegeven. Een schema is een vereenvoudigde weergave van de werkelijkheid. 

Maar een schema geeft wel heel snel een duidelijk beeld van de situatie. Dat is misschien persoonlijk. 

Maar als ik weet waar het zit dan is het genoeg. Hoe het er allemaal precies uit ziet maakt niet uit, een 

muur is een muur. 

Is het van meerwaarde om extra informatie toe te voegen, zoals de afname van geluid in de ruimte? 

Voor mij wel. Want weet jij tot waar de overlast loopt en waar de overlast heel erg groot is en waar 

minder groot. Ja dat is zeker van toegevoegde waarde. Er is een verschil tussen noodzaak en 

toegevoegde waarde maar ik zou daar wel iets mee kunnen ja.  

Is het van meerwaarde om sensordata te visualiseren op objecten, bijv. gebouwen?  

Ik denk dat dat wel makkelijk is want dan kun je heel snel zien wie boven gemiddeld presteert of wie 

veel geluid maakt.  

Is het van belang om regelgeving mee te nemen in een visualisatie?  

Ik denk het wel want dat bepaald uiteindelijk of je iemand wel of niet moet waarschuwen. Zolang die 

beneden het overeengekomen dB is, al is dat wel meer voor belang voor de controlerende instanties 

en de exploiterende instanties. Wij leveren horecaondernemingen heel vaak op inclusief 

geluidsinstallatie omdat dat redelijk kostbare investeringen zijn. Daar zouden we het kunnen 

gebruiken om af te stemmen op welk geluidsniveau wij opleveren. Dat kan tegenwoordig met een 

rapport. Daarin staat hoeveel dB wij kunnen en mogen produceren.  

Hoe specifiek moet tijd worden weergegeven?  

Tijd is zeker wel van belang. Afhankelijk van de vraagstukken, als bijvoorbeeld een bewoner klaagt. 

Dan moeten we het tijdstip van klagen kunnen matchen met het tijdstip van het produceren van 

geluid. Als dat niet matcht dan heb je een probleem dus dat moet zo specifiek mogelijk worden 

weergegeven. 

Zou je achteraf data van een bepaald tijdstip willen opvragen of van een groter tijdsblok?  

Ik zou het wel willen weten van de piekmomenten. Bijvoorbeeld van de hoogste 3 momenten. Want 

die zijn relevant. Alles wat in het gemiddelde gebeurd is niet relevant want dan overschrijd je niet de 

grens en dan heeft niemand er last van. Als ze klagen dan is het vaak op piekmomenten.  
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Hoe gedetailleerd moet het tijdsinterval van data zijn?   

Dat hoeft niet zo heel gedetailleerd. Dat kan voor mij ook een interval van een minuut of 5 minuten 

zijn in plaats van het gemeten 10 seconden interval.  

Zijn er verder nog dingen die belangrijk zijn voor een visualisatie van sensorgegevens?  

Nee als pandeigenaar hebben wij daar weinig direct belang bij. Ik zou me kunnen voorstellen dat je 

aan de hand van grafiekjes en uitingen kunt laten zien dat de geluidsoverlast alleen op 3 of 2 

tijdstippen wilt weten en dat je dat je niet of nauwelijks geluid produceert. Alleen in deze markt is dat 

niet relevant. Iedereen weet dat als je het muisstil wilt hebben dat je dan niet in Stratumseind moet 

gaan wonen. Ik zou dus niet 1, 2, 3 toepassingen weten. Misschien een juridische procedure of 

verkoopbaarheid. De telcamera’s zouden kunnen worden gebruikt voor het vaststellen van de 

huurprijs. Voor de exploitanten en voor de gemeente is dat soort informatie veel belangrijker. Ik vind 

het living lab wel een heel interessant iets. Wat weet ik nog niet maar ik denk wel dat het hele leuke 

dingen gaat brengen. Ik denk dat er leuke toepassingen zijn. We moeten vooral blijven zorgen dat er 

genoeg bezoekers blijven komen en daar staat nog wel een uitdaging. De aantrekkingskracht moet 

blijven maar dat is een leuke uitdaging. Het is uiteindelijk namelijk wel in ons belang om de kwaliteit 

van die straat op te krikken. Wij hebben het geluk, of pech gehad dat wij die panden in 2004 hebben 

gekocht. Die zijn dus redelijk nieuw. Die zijn dus compleet herontwikkeld en gerenoveerd. Wij hebben 

dus de best geisoleerde panden van Stratumsiend. Alleen ik zou het niet erg vinden, sterker nog ik zou 

het toejuichen, als de rest van de straat ook wordt gerenoveerd. Bij ons zit een ander soort publiek in 

de appartementen dan de appartementen die bijna uit elkaar vallen. Ja dat is een andere prijs en 

ander publiek met andere eisen. En als je een ander publiek daar hebt wonen dan komt er wel meer 

beweging. Bij ons is er overdag ook beweging. Wij hebben bijvoorbeeld 1 kantoorhuurder en daar ben 

ik heel erg blij mee. Daar zijn van ’s ochtends 10 tot ’s avonds 11 mensen. Daar is beweging. Maar de 

rest daar kun je een kanon afschieten en dan raak je geen mens. Stratumseind 20 jaar geleden was het 

vrijdagmiddag 12 uur en dan zag het zwart van de mensen. Toen gooiden de studenten op 

vrijdagmiddag de boekentas weg en gingen ze naar Stratumseind. Maarja, dat is niet meer. Maar 

goed, dat is een leuke uitdaging. Doordat de pandeigenaren niet direct belang hebben bij de 

sensordata is het altijd lastig om deze doelgroep te betrekken bij dit soort projecten. Zolang het pand 

is verhuurd geven ze nergens geen zak om. En ze zijn het niet gewend dat ze ervoor moeten werken 

en dat een pand niet vanzelf vol komt. Dat is niet meer. Dat maakt het wel lastig. Living lab vind ik zelf 

wel interessant omdat er dusdanig veel instanties worden samengebracht. 
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APPENDIX IV: ROADMAP 
 

This appendix contains an extensive roadmap that can be used by the municipality of Eindhoven to 

repeat the steps taken in the practical part of the research. The software versions used to execute 

these steps are ArcGIS 10.2.2 and SketchUp 8. All italic text specifically applies to the data used for this 

research.  

A. | Add 3D city model (and sensor locations) to ArcScene  
The section describes how the already available 3D city model can be shown the right way using 

ArcScene.  

 Open ArcScene 

 Click the ‘Add Data’ button 

 Connect to the desired folder or geodatabase (Eindhoven_1.gdb) via the ‘Connect to Folder’ 

button 

 Add the required shapefiles (pand, overstek, overigbouwwerk) to your map 

If the previous steps are completed successfully, the map now shows the rooftops of the buildings. 

This image is however rather chaotic and no overview of the volume of the buildings and the walls yet. 

Therefore the objects should be extruded. 

 Double click on the buildings layers (pand) 

 Click the tab ‘Extrusion’ 

 Check the box ‘Extrude features in layer. Extrusion turns points into vertical lines, lines into 

walls and polygons into blocks’ 

 Apply extrusion by ‘using it as a value that features are extruded to’ 

 Repeat these steps for the other buildings shapefile (overig bouwwerk) 

 Repeat the steps once again for the overhang (overstek) layer but be sure to choose ‘adding it 

to each feature’s maximum height’ in the extrusion tab 

The map now contains part of the 3D city model. However the buildings are relatively high and this 

image does not match the height of buildings in reality. That is because the ground level is not yet 

added to the map. 

 Repeat the ‘Add data’ steps but now connect to the Eindhoven_maaiveld geodatabase 

 Add the ground level shapefile of the relevant city district (Eindhoven_1_maaiveld) to the map  

The city model is now complete. The image might still look a little weird as buildings exist under the 

ground level. To rectify this the ground level shapefile can also be extruded in the same way the 

buildings were extruded earlier. Now the sensor locations can be added to the map. 

 Open Excel 

 Create a sheet with at least 4 columns: SensorType, X, Y and Z. The SensorType column shows 

whether the sensor is for instance a microphone or a camera. The X, Y and Z columns show 

the coordinates conform the Dutch RD new projection system 

 Go back to ArcScene 

 Click ‘Add Data’ 

 Add the Excel sheet to the map 



85 
 

 Right click on the table and choose ‘Display XY Data’  

 Select the right attribute for the right coordinate and make sure that the Z coordinate is 

specified as well 

 Select the right coordinate system (RD new) and click OK 

The scene now contains the 3D city model with the sensor locations. 

B. | Line of Sight analysis 
The term line of sight analysis might sound weird for noise sensors. This is because line of sight 

analyses as they are called in GIS software can help to better determine the noise source. It is thus not 

used as a literal line of sight but the principles are the same. The steps needed to perform these 

analyses are stated below.  

 Open ArcScene 

 Open the shapefiles of the city model and extrude them as explained in section A of this 

appendix 

For this analysis a succession of tools in ArcScene are needed. To make this easier, a ModelBuilder 

model has been created to easily repeat these steps. There are two versions of the model. The 

standard version and the extended version. The standard version can be used to create the visibility 

lines that show the difference between the current noise source determination method and the new 

one as explained in this research. The extended version of the model also adds the LAeq attribute to 

the sightlines and these can thus be used to visualise the actual dB level measured by the sensor. The 

standard model just needs a run and is then ready. The extended version needs some additional steps 

that will be explained below: 

 Click the ‘Select by location’ tool 

 Select from the lines all lines that intersect with the sensor locations layer 

 Right click on the lines layer and choose Selection > Create layer from selected features 

 Double click on the layer and visualise the LAeq attribute  

The ModelBuilder models can be easily adjusted and are very useful when visualising another sensor, 

or sensor data from another point of time.  

C. | Determine azimuth angle of cameras 
Information about the azimuth is very important when visualising camera field of views. The azimuth 

reflects the horizontal viewing direction of a camera. An approximate of the azimuth can be 

determined by following the steps below. 

 Open ArcMap 

 Click ‘Add data’ and load (1) the camera locations shapefile and (2) an aerial photo of the area 

 Download and install the software ‘ScreenScales’ (or similar software tools). ScreenScales is 

available via http://www.softpedia.com/get/Desktop-Enhancements/Other-Desktop-

Enhancements/Screen-Scales.shtml  

 Open ScreenScales 

 Right click on one of the points and choose ‘Show Angles’ 

 Right click on the points again and choose for ‘Add point’ 

 Drag the middle point to one of the camera points in the ArcMap document 

http://www.softpedia.com/get/Desktop-Enhancements/Other-Desktop-Enhancements/Screen-Scales.shtml
http://www.softpedia.com/get/Desktop-Enhancements/Other-Desktop-Enhancements/Screen-Scales.shtml
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 Drag one of the other points exactly (with a straight line) above the point on the camera 

 Drag the final point to the location on the aerial photo that matches the middle of the camera 

live view (also a screenshot of the camera can be used for this) 

 Write down the azimuth angle. Be sure that this angle is determined counter-clockwise (as 

this is the value that should be used in ArcMap later on). Also note that the angles are shown 

on only one half until 180 degrees while an azimuth is between 0 and 360 degrees 

D. |  Visualise camera field of views on existing objects using SketchUp 
This section describes how camera field of views can be added to objects of the 3D city model in 

ArcScene. The starting point for these steps is the output of the ‘Add 3D city model to ArcScene’ 

roadmap.  

 Download SketchUp 8, available for free via http://www.sketchup.com/download/all  

 Download the Axis camera extension for SketchUp. This extension is available for free via 

http://www.axis.com/techsup/system_design_tools/camera_extension/ 

 Open SketchUp 

 Install the Axis extension via Window > Preferences > Install Extension. Select the right .rbz file 

and install the extension 

 Open ArcScene 

 Make sure that the 3D analyst extension is enabled. Check this by going to ‘Customize’ in the 

upper ribbon, then click on ‘Extensions…’. The 3D analyst box should be checked. 

 Go to 3D Analyst tools > Conversion. Click at the ‘Layer 3D to feature class’ tool. Select the 

layer of the buildings that should be converted into a feature class. Specify the output class 

and run the tool. A new feature class layer will be created 

 Go to Conversion tools > To Collada and click the ‘Multipatch to Collada’ tool. Select the 

previously created feature class as the input layer and specify the output location. Run the 

tool 

 Use the ‘Identify’ icon to see the ID number of the object you want to attach your camera to.   

 Go back to SketchUp 

 Select File > Import. Select the .dae file (which is a Collada file) with the identified number of 

the building you want to edit. Import the file 

 Look at the red icons of the mount tools and choose the appropriate mount, in this case a wall 

mount or a corner mount. Add the mount to the right place of the building 

 Select the mount and click on the icon ‘Show/Hide Settings panel’ 

 Select the camera series with the specifications (min. focal length 3mm and max. focal length 

9mm) most similar to the camera that is used. Note that these specifications can be adjusted 

later on. If the camera is of the brand Axis the exact camera type can be chosen 

The SketchUp model now provides insight in the location of the camera with its associated field of 

view. To increase the accuracy of the FoV, some settings should be adjusted. 

 The ‘Pan Camera’ icon can be used to adjust the azimuth and thus to adjust the horizontal 

viewing direction of the camera 

 The ‘Tilt Camera’ icon can be used to adjust the tilt angle and thus the vertical viewing 

direction 

http://www.sketchup.com/download/all
http://www.axis.com/techsup/system_design_tools/camera_extension/
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 The ‘Adjust Focal Length’ icon is used to change the focal length settings. These settings are 

used for zooming. The bigger the focal length, the more the camera is zoomed in. In this case 

the minimum focal length is 3mm and the maximum focal length is 9mm.  

The Axis extension has even more advanced options, e.g. to adjust the FoV cutoff, to specify the target 

resolution et cetera. They will not be further explained here but please notice they are available. If the 

FoV is created the right way it is ready to be exported back to ArcScene. 

 Choose File > Save as. Save it as a SketchUp version 5 .skp format.  

 Go back to ArcScene 

 Click with the right mouse button in the upper ribbon to make sure that the 3D editor is 

enabled 

 In the 3D editor toolbar click 3D Editor > Start editing. Select the right layer to edit (pand) 

 Select the right building via the ‘Select Features’ tool 

 Again click 3D Editor > Replace with model. Choose the right model that was just saved in 

Google SketchUp 

The building with the camera and its field of view is now added to the scene.  

E. | Visualise camera field of views on poles using SketchUp 
This section describes how camera field of views can be added to the 3D city model when the camera 

is not attached to an existing object of the city model, in this case when they are attached to poles.  

 Open SketchUp 

 Click the circle icon to draw a circle on the ground. The lower right corner shows the radius. If 

this radius is not represented in the preferred unit (e.g. feet and inches instead of meters) this 

can be changed via the Window > Preferences > Template 

 Use the push/pull icon to extrude the circle to the right height. Notice that the height should 

match the height above Z = 0 and not the height above the ground level 

 Look at the red icons of the mount tools and choose the appropriate mount, in this case a 

pole mount. Add the mount to the pole 

 Select the mount and click on the icon ‘Show/Hide Settings panel’ 

 Select the camera series with the specifications (min. focal length 3mm and max. focal length 

9mm) most similar to the camera that is used. Note that these specifications can be adjusted 

later on. If the camera is of the brand Axis the exact camera type can be chosen 

The SketchUp model now provides insight in the location of the camera with its associated field of 

view. To increase the accuracy of the FoV, some settings should be adjusted. 

 The ‘Pan Camera’ icon can be used to adjust the azimuth and thus to adjust the horizontal 

viewing direction of the camera 

 The ‘Tilt Camera’ icon can be used to adjust the tilt angle and thus the vertical viewing 

direction 

 The ‘Adjust Focal Length’ icon is used to change the focal length settings. These settings are 

used for zooming. The bigger the focal length, the more the camera is zoomed in. In this case 

the minimum focal length is 3mm and the maximum focal length is 9mm 

 Remove the standard woman by selecting it and clicking the delete button 

 Click File > Export > 3D model and save the model as a .dae Collada file 
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 Open ArcScene 

 Click ‘Add Data’ 

 Open the Excel sheet with the coordinates created earlier 

 Right click on the table and choose ‘Display XY Data’ 

 Choose the right attributes for the X and Y coordinates but do NOT specify the Z coordinate 

 Go 3D Analyst tools > Conversion > From File > Import 3D files 

 Select the Collada file and choose a directory to save the output feature class. Click OK 

 Enable the 3D Editor toolbar 

 Choose 3D Editor > Start Editing and choose the 3D feature class 

 Click the Edit Placement button 

 Click the feature that should be moved 

 Press the ‘M’ key 

 Enter the right coordinates to move your feature to. These are the coordinates of the points 

without a Z coordinate that were added to the scene earlier 

 Correct wrong locations (the midpoint of the 3D feature is used to locate it but in reality the 

camera should be located at the point) by dragging the mouse while the feature is still 

selected 

The camera field of views are now added to the scene.  

 

F. | Visualise camera field of views with the Geodan algorithm  
This section describes how the 3D field of view toolbox from Geodan can be used to visualise the field 

of views. This toolbox is created by Azarakhsh Rafiee, a PhD student and researcher/developer at the 

VU University and Geodan. The toolbox is based on an algorithm developed with the game engine 

Unity. A script is written to create a ArcGIS toolbox that can be used to easily reconstruct the FoVs in 

ArcScene. The toolbox is however not ready yet as it does currently not contain all needed 

parameters. With the aid of some additional steps the toolbox is still useful to easily create FoVs. All 

steps are stated below.  

 Open ArcScene 

 Click on the red ‘ArcToolbox’ button 

 Right click on ArcToolbox and click ‘Add toolbox’ 

 Select the Geodan FoV toolbox from the correct folder 

 Double click on the newly added toolbox 

 Fill in the coordinates of the sensor. Make sure that the coordinates are stated in the RD 

projection system. 

 Enter the focal length (between 0,03 and 0,09). Note that many cameras have a minimum 

focal length and a maximum focal length. The larger the focal length, the more the camera is 

zoomed in. By running the toolbox twice, both the minimum and the maximum focal length 

can be examined.  

 Specify the output location and run the tool 

A FoV shapefile is now created. However as the tool is not ready yet the output shapefiles have an 

azimuth and vertical angle of 0.  

 Open the 3D Editor toolbar by right clicking on the upper ribbon and selecting the 3D Editor 
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 Start an edit session 

 Select the FoV shapefile as the layer to be edited 

 Right click on the FoV shapefile in the table of contents and choose Selection > Select All 

 In the 3D Editor click on 3D Editor > Rotate… 

 Fill in the azimuth determined during step C 

The shapefile now has the right azimuth, however the rotation was made from the middle point of the 

shapefile instead of an arbitrary point. The shapefile should thus be moved to the right location. 

 Again click 3D Editor in the toolbar and click ‘Move…’ 

 Move the shapefile to the right location (the location of the camera). Make sure to use the 

navigate tool to make sure that the shapefile is well positioned 

The ArcScene document already provides a nice overview of the location and viewing direction of the 

camera. However it still has a vertical angle of 0. CityEngine can be used to rotate the shapefile 

vertically.  

 Open CityEngine 

 Create a new scene by clicking File > New > CityEngine Project 

 Repeat the previous step but then create a new CityEngine Scene 

 Go back to ArcScene 

 Right click on the camera field of view layer in ArcScene and click Data > Export Data 

 Save the shapefiles in the data folder of the newly created CityEngine project 

 Go to CityEngine 

 In the Navigator on the left side of the screen expand the data folder (refresh if needed) and 

drag the shapefiles into the scene 

 Right click on one of the field of view layers in the lower left corner and choose Select > Select 

objects in same layer 

 Select the rotate tool from the upper ribbon 

 Rotate the field of view vertically until the desired result is met 

 Select the move tool from the upper ribbon 

 Drag the field of view to the right position of the sensor location 

The camera field of views are now both horizontally and vertically adjusted. It is possible to further 

visualise the field of views in CityEngine by using rule packages, but otherwise the field of views can be 

easily exported to ArcScene. 

 Select the layers in CityEngine that should be exported 

 Click File > Export > Export selected shapes 

 Save the shapefiles in the right folder 

The field of views can now be opened in for instance ArcScene to improve the visualisation. The 

properties window enables one to adjust the colour or to make the shapefile transparent.   

 


